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Chapter 1. About cardPresso

cardPresso,  Lda  is  always  developing  cutting  edge  ID  Card  solutions.  Our  team  has  R&D
technologies and extensive ID software development skills and experience. The result of our efforts  is
the Next Generation of Plastic Card Software - cardPresso

Our programmers use the most recent innovations from different  fields  of information and ID security
technologies.  Our goal is  to create the perfect  balance of functionality  and usability,  while ensuring
end users ease in using our software. We're constantly exceeding our goals through the team efforts
of our developers, analysts, resellers and our most important contributors our clients.

1.1 Overview

Welcome to cardPresso.

cardPresso is more than an application...

Why? Well, cardPresso is not only  a very  simple software,  but  also powerful and user friendly.  We
have  a  dedicated  and  experienced  team  of  professionals,  support  experts,  software  development
innovators  and sales  specialists,  including  our  distributors  that  provide  you  with  the  best  software
solution on the market.

cardPresso  is  committed  to  a  continuous  software  improvement  by  responding  to  the  clients
requests,  keeping  in  touch  with  new technologies  and  anticipating  the  needs  of  an  ever-changing
plastic  card  industry.  Our  worldwide  staff  is  available  to  assist  you  as  needed  through  training,
technical  support,  sales  information  or  through  a  wide  range  of  services  including  full  software
customization, stand alone projects or embedded projects, headed or followed by cardPresso.

cardPresso allows you to create a card from scratch to production,  without  any outsource program
to deal with any aspect of the card creation process, like image treatment or card encoding and even
the database connection issue, because cardPresso can connect to any database. 

cardPresso's capability of working on Mac and Windows Operating Systems have been the market
revolution, satisfying both end-users. This has been not only a challenge but also a commitment  that
allows cardPresso to work with a world wide range of clients.

Whether it’s  automating routine tasks or solving  your  toughest  IT challenges,  cardPresso  delivers
rapid value and simplifies the plastic card creation process management, across physical, virtual and
cloud environments.  And that  means less  chaos and stress  for you,  plus,  big cost-savings for your
organization.
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1.2 Features

Software Box and Installation
cardPresso comes with a full setup on an USB key that allows you to work on Windows or Mac and
carry your work with you. It also brings a Digital Manual in PDF, card templates,  clipart  and shapes
and allows a group and user log-in management.

Tools & Image
cardPresso has on it's  tools  a strong hold for its  users,  like 1D and 2D barcodes,  variable objects,
templates,  text  setup,  full  image  acquisition,  face  detection  and  a  complete  built-in  image  editor.
You also have access to a multi-layout design option.

User Interface
cardPresso has five different views:
- the Welcome View where you define how yo start or resume a previous card creation process,
- the Users View where you can define groups and user log-in management,
- the  Document  View that  gives  you  a  complete  overview of  the  document  and  at  the  same  time
allows you to work directly on the card design,
- the Database View that is a full manipulation tool,
- and finally the encode view where you can setup your card encoding.

Print
cardPresso offers a front and back print option, SDK driver printing,  ethernet  printer support,  overlay
panel  management  and  batch  printing,  print  status  and  in  some  editions  conditional  printing  over
database.

Database
cardPresso allows you to connect  to any kind of database,  such as  CSV, Excel,  Access,  among
others. cardPresso brings an internal database with photo connection and a powerful database tool
set  where  you  can  create  and  edit  a  database,  link  an  image  to  a  field,  browse,  filter  and  find
records, and concatenation options.

Encoding
This  feature  allows  magnetic  encoding,  contact  smartcard  plugin,  contact  smartcard  encoding,
contactless  RFID encoding and internal  /  external  RFID encoding.  cardPresso  has  also  internal  /
external RFID encoder support.

Miscellaneous
cardPresso gives you free updates and automatic edition upgrades.
A user log that permits a step-by-step follow up of your work.
And a programming script (JavaScript, based on ECMA Script Language Specification). 
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1.3 Security

cardPresso, Lda team has opted for an USB pen solution that comes with a full setup. 

Why? Because through this  pen you can work  in any PC or Mac with the advantage  to  carry  your
work with you and also because it makes easier to recover your license online through cardPresso,
Lda.

This  is  a  4GB pen,  which means that  a lot  of  work  can  be  carried  on  it,  your  card  files,  images,
databases and anything elase you might need to carry with you.

 Advice: Always make a copy of your work. All data on your pen is recoverable except your work.
A pen is a piece of hardware as reliable as any other.
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Chapter 2. Installation and Support

cardPresso is easy to install and customize.

2.1 Installing cardPresso

For Windows installation, please follow the steps covered on the the topics Windows Installation.

2.1.1 Windows Installation

Connect  the  provided  USB  key  on  one  of  your  available  USB  ports.  The  AutoPlay  will  run
automatically and choose the 'Open Folder to view files' option.

Double-click on the cardPresso executable file and the Installation Wizard will  run.  The Installation
Wizard  is  displayed  where  you  can  verify  the  Serial  Number  of  your  product  and  also  select  the
language to install. To proceed with the installation click the 'Next' button.

Install or Evaluate
Select the installation folder. By default cardPresso software is installed on the Programs Folder but
you can select another destination folder by selecting the 'Select Destination folder' option.

Check  the  option  'Install  for  all  users'  if  you  want  other  Windows  users  to  also  run  cardPresso
software. Click 'Next' to continue.

If you want to run the application without installing it please click 'Evaluate'.
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.

Shortcuts
Check the shortcuts  that  you want  to create for easy access to the application,  and if you wish  to
open card files  immediately  with cardPresso  select  the file associations checkbox.  Click  'Next' to
continue.

Finish
Click 'Finish' to install cardPresso software.
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2.1.2 Mac OS X Installation

Install
Plug the USB key and double click on USB drive icon, then double-click on the cardPresso.dmg file
and the end user license agreement appears, click 'Agree' in order to proceed.

Now drag and Drop the cardPresso icon into the Applications folder alias to install.
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2.2 Changing Language

You can change the language of the user interface at any time.

To change the language of the cardPresso software,  click  "CP" ->  Language.  Choose  the  desired
language from the list and restart the application to apply the new language settings.
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2.3 Updating cardPresso

We advise to keep always your cardPresso software updated. In order to do so please go to http://
www.cardpresso.com website and download the setup required for your operating system.

2.4 cardPresso Support

cardPresso,  Lda's team  treasures  the  relationship  with  our  costumers,  keeping  it  as  close  and
personal as possible. We are committed to offer you the best support.

We can offer support by phone, email, Skype or remote sessions (Team Viewer):

(+351) 261 866 163

support@cardpresso.com

cardpresso.support



Chapter 3.
Getting Started



cardPresso Manual20

© 2014 cardPresso, Lda

Chapter 3. Getting Started

 This  chapter explains  how to handle a document,  model or template,  how to create or open an
existing file and also how to recover a backup file.

Document - Contains all data related to your work, including the chosen model or template, all
objects, database connections, properties, encoding properties. In sum, all the properties involved in
your card document creation.

Model - Contains all the features and shape of your physical card. These features are size and card
type, if it is a basic card, contactless, magnetic or smartcard. Please notice that the card settings
depends on your chosen or created model type. For instance, you can't access the chip encoding
settings if you've chosen or created a card without SmartCard capabilities.

Template  - Is  no more then a pre-made document  layout  used  to  create  a  new document  with  a
similar design,  pattern,  or style.  This  means that  you can use an existing template as  it  is  or  you
can change it as you wish, creating a new document or template from the opened template.

Backup - cardPresso automatically generates a backup file of your document  every  time it's  saved.
This  backup is  created on a pre-defined folder ('\My Cards\Backups') with the  document  name  and
date/time creation.

 This document can be recovered any time you need. 
Example: documentname(yyyymmddThhmmss).cardBackup
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3.1 - Welcome View

 Welcome View

The welcome view is your starting point when it comes to working with cardPresso.
Here you can create new card models,  open existing card models  or previously  made templates,  or
even create a basic card with a step by step guide.

Here you can also access the Users  View (only  on cardPresso XL Edition or higher) or simply  quit
cardPresso.

 

To return to the Welcome View at any time:

 Click Window menu  Welcome View

 You can get help in different ways. Choosing "Help" from the Help menu or context-sensitive help
that is always available by pressing the F1 with the cursor located on the element on which you want
help. In addition, many dialog boxes contain a Help button.

.
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3.1.1 - CP Menu

The top menu bar, gives you access to the "CP" menu.
Here you can find information related with cardPresso.

 About cardPresso, Show your release, edition and serial number.

 Clear Config,  Sets  cardPresso all  settings to default,  including print  settings,  object  settings
even work space.

 USB Devices, Show every information about your cardPresso license pen,  the drive ID and the
serial number, if this information is not shown then your pen has not been recognized by the system,
please check it.

 Update  Security,  Show information  about   your  cardPresso  license  pen  and  allows  online
upgrade.

 View  Folders,  Show information about  cardPresso working folders.  If  you  don't  find  a  file   or
don't know where cardPresso keeps it's  folders  like cliparts,  backups,  shapes,  etc,  you can check
on this list it's location. 
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 Printer Drivers, Show information about the printers and drivers  installed on your computer and
if you  click  on  'View All  Supported  cardPresso  Printers'  you  have  access  to  a  list  of  compatible
encoding printers. 

 Language, Allows you to choose the language in which cardPresso is presented
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3.2 - Creating a New Card

The first step to printing cards is creating your own card. 

 To create new card, in the Welcome View  Click Create New Card button

Or  Click File menu  New ( CRTL+N )

Then you can then choose the Card Type that you intend to use from our list of supported Card
Types:
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After selecting the Card Type, the cardPresso Design View will automatically open, giving you
acces to al the tools you ned to add and edit content to your new card.
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3.3 - Open Your Own Card Documents

 In cardPresso there are two kinds of files,  the ones you create,  called card documents  and the
ones created by cardPresso designated by backup files.

To better organize your documents,  in the "Open Card"  window, you find "cardPresso Favorites"
with two folders  - "My Recent Cards" and "My Cards".  Or alternatively  you may locate your file in
another folder in "My Computer".

You  can  sort  the  way  how  the  cards  are  displayed.  You  may  sort  them  by  Name,  Name
Descending, Modification Time, Modification Time Descending, File Size and File Size Descending.

 In the lower right  corner you can find the information about  how many readable  documents  are
currently present in the selected folder, or the name for the current selected card document.
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3.3.1 - Open an Existing Card Document

 You can open an existing card document to edit,  change or even print  again.  The existing card
always keeps the last saved properties.

The first  step will  be to locate the document card that  you wish to open.  In order  to  do  so,  please
click the 'Open' button on the "Welcome View" or use the 'Open' option from the 'File' menu.

 Click File  Open ( CRTL + O )  Explorer and locate your card with extension .card  

 Click OK.

 Your file should have the extension .card

 Select the file extension in the corresponding Combo Box, otherwise your file will not be listed.
To proceed "Open".

 Also remember that you can open the file directly from Windows by double clicking on on it
inside Windows Explorer.
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3.3.2 - Recover Your Card Documents From Backups

 A backup is  a file that  cardPresso automatically  creates  every  time you save a document in a
internal or  external  drive.  The  file  will  be  saved  with  a  date  and  time  reference  to  make  easier  to
detect  the  last  backup  made.  Like  this  you  have  the  assurance  that  you  have  a  copy  of  your
document in a specific date/time, in the backups folder.

Before opening your backup,  you should know where cardPresso created the backup folder  during
installation. To check the path:

 Click cP  View Folders 

 Now  that  you  know  where  your  backups  are  stored   (.../users/.../Documents/My  Cards/
Backups ), you can easily locate the backup document that you need to recover.

  Click File  Open  Explorer  cardPresso Favorites  My Cards    Backups and
select your backup document in the folder "Backups"

 Remember that your backup has a 'filename(savedateTsavetime).cardBakup' filename
convention.

 Click OK.
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 Your file should have the extension .cardBackup

Now all you have to do is to save your document with another name and with .card extension.

 Select the correct file extension in the corresponding Combo Box, otherwise your file will no be
listed.
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3.4 - Using Templates

 A template is a collection of styles  that  control the layout  and appearance of a card document.
You can quickly create your card document using one of our many templates. 

cardPresso provides these templates organized in categories, such as  Test  and diagnostic;  Sports;
Shopping; Schools; Loyalty; Clubs & Resorts; Business; Activities and Access Control.

But if for some reason this categories don't fit your needs,  you can always create new ones,  just  go
to  My  Templates  directory  and  once  there  create  a  new folder  and  cardPresso  will  assume  that
folder to be a template category.

The  Templates  cover  a  wide  range  of  graphics  and  variable  field  types,  all  of  them  fully  editable.
These professional templates  are part  of your cardPresso software.  Your cardPresso USB  dongle
also contains additional templates.
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3.4.1 - Create from Existing Template

 To create a document from a template, in Welcome View  Click Templates

Or  Click File menu  Open Template ( CRTL+SHIFT + O )

 In the dialog box, search thru the available templates.

 You can create a card based on a template and then modify  the document without  affecting the
original template

 By making changes to the background, images, text, and orientation card. You can create a new
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design to suit your needs. You can also modify any card object in your document. 

 All you have to do now is to save your new card document.

3.4.2 - Create Your Own Templates

 If the preset templates do not meet your requirements, you can create a template based on your
own styles.

To create your own template, start by creating a new card and chose a model type that fits your
need. For instance, if you chose for example a contactless model, the result will be a template
based on your contactless, but with your own design.

 Click 'OK'. If you want to continue. Otherwise click 'Close' to revert to the previous window.

 A template may include any object type, variable field or text that can be edited and modified at
any time. Make all the changes you want on your template and then save it  with '.cardTemplate' file
extension, in the appropriate folder in cardPresso (.../My Cards/My Templates/...).

 Click File  Save or Save as and create your file.

 Your file should have the extension .cardTemplate

 You can edit your template at any time.

  Click File  Open  Explorer 
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 Select the file extension ".cardTemplate" in the corresponding Combo Box, otherwise the
template files will not be listed.

 After you have completed  your  template  edition   click  Save  and  your  old  template  will  be
replaced with the new modifications.

3.5 - Using Models

 cardPresso allows you to create a document  in two different  ways,  by  using an existing model
or by creating your own card model.

The first one only requires you to choose one of the many different  type of models  that  cardPresso
has  at  your  disposal.  Like  mentioned  before,  you  have  four  major  kinds  of  card  models:  basic,
contactless, contact smart card and magnetic, and each type can have different  settings like sizes,
different kinds of magnetic strips and so on, all listed on cardPresso model type. 

But  if you have a specific  type of card model that  is  not  listed,  cardPresso allows you to create  it
and that's the other way to create a document, using a new card model.

 Note that  whatever model you choose,  it  will  restrict  access to  further  settings  and  properties,
like referred before. If you open a "Contact  Smart  Card",  the result  will  be a model of your "Contact
Smart  Card",  where you can only  edit  Smart  Card Settings,  and it  will  not  allow you to access,  for
instance, RFID settings.
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3.5.1 - Create from Existing Model

 This topic guides you on how to create a new document using an existing model.  You can start
a creation procedure by clicking on the create button on the "Welcome View".

 'Welcome View'  'Click Create' 

Or  'Click File' menu  'New' ( CRTL+N )

 Then choose the type of model you want. The model types are organized in 8 groups: 

 Basic card models,  have no contacts,  no microprocessors  or internal memory.  Simple piece of
plastic that you can print in front and back side.

 Common card types, are the most common types of card models, used by  the vast  majority  of
users.

 Magnetic this  model type allows you to encode the magnetic  stripe through cardPresso.  This
means that you can print and encode your card at the same time or use an external encoder.  These
cards may contain secondary technology, like RFID technology.

 Contactless card is  any pocket-sized card with embedded integrated circuits  that  can process
and store data, and communicate with a terminal via radio waves. This type of card model allows you
to  encode  through  cardPresso.  By  using  JavaScript  language,  you  can  program  your  card  and
perform read and write operation on the card.  This  also means that  you can print  and  encode  your
card at the same time or use an external encoder. 

 Mifare,  this  card model,  when chosen,  allows you to read or write the  several  sectors  of  your
card. By using JavaScript language you can connect the sectors to database fields and update them
automatically or simply enter data through keyboard input, therefore you can print  and encode at  the
same time. These cards may contain secondary technology, like Magnetic stripes.
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 Contact, a smart  card,  chip card,  or integrated circuit  card (ICC) is  any pocket-sized card with
embedded integrated circuits.  In cardPresso you have four types of card models,  I2C,  JCOP  (Java
Card), SLE4442 and generic. This type of card model allows you to encode through cardPresso.  By
using JavaScript  language,  you can program your card and perform read and write operation on the
card. This also means that you can print and encode your card at  the same time or use an external
encoder. 

 Unusual,  set  of models  used by  a small number of users.  Model  types  developed  for  specific
projects are now included on this group.

 User Models,  if you have any models  in folder "My Models",  they will  become available in this
group.

After you have choose the model type,  'Click OK' and you will be able to start working on your

new card. Or  'Click Close' if you want to revert to the previous window.
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 For your first card design, check also the Objects and Properties topic.
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3.5.2 - Create Your Own Model

 To create a document  using a new model,  you have to start  by  creating the model.  This  will  be
your starting point to customize your own document. 

Your  next  step  is  to  save  that  same  model  with  the  extension  '.cardModel'  and  save  it  on
cardPresso folder called "My Documents/My Models" in order to be identified as a model.

 It is important that you save your file in the folder "My Models",  to be displayed in the category
"My Models" in "Select model type".

 Click File   Save  or Save  as and  create  your  file  as  the  example  below,  in  your  folder  "My

Documents" (To see this folder locations, please click on menu  cP  View Folders)

 Your file must be saved with the extension .cardModel

 At  this  point,  you've  created  your  new model  "yourdoc.cardModel."  The  next  step  will  be  to
locate your file and open it.

  Click File  Open  Explorer  cardPresso Favorites  My Cards  
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 Select the file extension in the corresponding combo box, otherwise your file will not be listed.

 After opening the model,  you  can  customize  the  dimensions and  corners radius.  On  your
right  on  the  properties  tabs  you  will  find  a  tab  named  "Layout"  where  you  can  change  the  card
dimensions and corners radius,

You can also change the orientation of your card by    clicking on File  menu  Configure  Print

and In "Print  Layout"   Click Orientation and select  your  card  orientation.  The  card  orientation
can be changed at any time, but this will be your card default orientation. 
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 You can add images, text or other elements to customize the thumbnail that  you will  see in the
preview area. 

 The last step is to save the model that  you've just  created.  From now on the new model will  be
displayed in the Create Document Dialog Box, under the category "My Models".

 Click File  Save (CRTL+S).

 Please note that cardModels can't be printed, they have to be saved as *.card before you can
print.



Chapter 4.
Design
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Chapter 4. Design

 The definition of design is  the creation of a plan or convention for the construction of an object
(as  in architectural blueprints,  engineering drawing,  business process,  circuit  diagrams  and  sewing
patterns). Design has different connotations in different  fields.  In some cases the direct  construction
of an object  (as  in  pottery,  engineering,  management,  cowboy  coding  and  graphic  design)  is  also
considered to be design.

Well,  in cardPresso you can also design and when you design you build a  layout.  To  accomplish
this, cardPresso provides the user with specific  tools  and objects,  allowing you to build your layout
according to your imagination, capabilities and needs.

 As you know, when you design you create a file,  called document,  this  document  keeps inside
all settings you will use on your creation. 

4.1 - Workspace

 In cardPresso you can customize your working area as  you wish.  You can reposition the menu
bars or you can view or hide properties areas.

 On the View menu you have a set of options that allows you to change your working scenario.

ToolBars

 Here you can select all the dockbars that should be available in the working space.

Metrics

 Allows you to define the measurement unit that you wish to work with. 

Rulers

 Visible - Show or hide the rules in the card design area.

 Selected Items - Shows or hide the area occupied by  selected items on top of the card design
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rulers Set 

Grid

 Visible - Set the card visible or hidden

 Snap to Grid - Allows you to move and/or position the objects on a grid unit step or free move

Workspace Color

 Allow you to chose the workspace background color 

 Switch between front or back card side.
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 Switch to Database View.
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 Switch to Encoding View.
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4.2 - Document Properties

 When you open the document view, the first thing you will see is the work space and on the right
side the basic properties of your card document.

 Backgrounds -  Each  layout  can  have  an  unique  background.  You  can  access  cardPresso
backgrounds library  using the Backgrounds Tab.  To apply  a background just  select  it  from  the  list
and  the  background  will  be  applied  immediately  to  your  card  layout.  You  can  also  set  the
background using an image object.

 Clipart - You can access it using the Clipart Tab. They can be used as  an image object,  part  of
your  card  layout  creation,  or  as  a  background.  Please  note  that  you  can  only  change  the
background color of the object.

 Layouts - Like we said before on this manual, when you design a card, you are building a layout
and in cardPresso, a document can have as many layouts as you want. The Layouts Tab is our way
to offer you a quick way to manage all the possible layouts on your card document. 

 Script  -  The  Script  Tab  allows  you  to  write  your  own  script  commands,  based  on  the
ECMEAScript language specifications. This is a way to extend the already large number of features
that cardPresso offers you. It also allows you to interact  with external software,  using the results  to
apply on your document. You have three different  kind of script  boards,  one for each object,  one for
the card document and one for encoding, three different ways to expand cardPresso capabilities.
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4.2.1 - Background

 An  image  to  be  applied  as  the  background  of  your  card.  cardPresso  offers  you  many
background images that can be used from landscape cards to portrait cards. 

 Background are divided in classes that are accessible through the background combobox. 

 It  it  possible to add a folder with images to use as  background,  in the  Background  Tab  All
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classes select #User Folder.

And select through the Explorer Browser the Folder with the images to use as Background.

It's also possible to use your own image as the card background.

Add  an  image  object  to  your  layout,  then  right  click  on  the  object   and  chose  'Set  as  a
Background' option, like shown on the picture bellow.
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If you want to change or edit the background, right click on the card and choose  'Edit
background'.
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The Image Editor will open and from there you can edit the background image. To commit changes, 

 click on the 'Save Changes' button, otherwise press 'Cancel' to continue.
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4.2.2 - Clipart

 Clipart are pre-made images that can be used to help on the layout  creation.  cardPresso offers
you several.

 They are divided in classes. All you have to do is select one class from the dropdown combobox.

 Select the image from the clipart list, and drag it to the card design area. The selected image will
be used as an image object that you can modify.
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4.2.3 - Layouts

 The Layout  Tab allows to define properties,  settings and conditions  for  the  use  of  the  layouts.
This  feature  allows  you  to  use  on  the  same  card  document  as  many  layouts  as  you  need  and
conditionally print the ones you want.

              

  

 Name - You can give a name to your layout.

 Add - You can add a new empty layout.

 Copy - Creates a new layout based on the current selected layout..

 Delete - Delete the selected layout.

 Auto Select Based on Database  Condition - When checked it  allows access to a  condition
box,  where you can define fields  and conditions  for  every  layout.  Remember  that  these  conditions
are restricted to the selected layout.

 After  you  enable  the  checkbox,  the  first  drop  list  shows  all  the  available  fields  from  the
connected database. You can apply conditions based on the available fields as you can see below.
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 Is Equal - Link the chosen layout to all records with the selected field equal to the input value.

 Is Not Equal - Link the chosen layout to all records with the selected field different from the input
value.

 Contains - Link the chosen layout, based on the field value,  to all  the records that  contains  the
input value.

 Not Contains -Link  the chosen layout,  based on the field value,  to  all  the  records  that  do  not
contains the input value.

 Is Null - Link the chosen layout to all records where the selected field is a null value.

 Is Not Null - Link the chosen layout to all records where the selected field is not a null value.

 After you have chosen one condition, you can set it  to match any string,  like shown on previous

picture , however please notice that the condition is not case sensitive.

 If the record doesn't comply to any condition it will assume the layout of the previous record.

 What benefits  may be obtained from using multiple layouts? To explain it,  we  will  show you  a
sample case using one of the predefined templates available with cardPresso.

 Now let’s imagine that  you have three different  departments  in your company,  Sales,  Marketing
and another one that for this example purpose we will call it General, but only  one database and you
need distinguish them visually for faster identification. The process is simple:

 After opening one of our predefined templates, a connection to an internal database will be made
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It’s time to start working on the card layouts. Now click on the Layout Tab.

As you can see you already have one layout, from cardPresso business card.

Now we will  add two new layouts  in  order  to  have  three  different  layouts  for  sales,  marketing  and
general departments.

To start, change one of the layout's  name to Marketing and then click  on the auto select  checkbox
to set the conditions.

On the database field,  choose the field that  will  define the layout  selection,  in this  case will  be  the
Position field.

Then in the next drop list set the condition for the chosen field, on our example we set it to
'Contains'.

And on the text  box below add a value for the condition.  In this  case  it  is  the  department's  name,
remember that this is not case sensitive.

Finally,  enable  the  'Auto  select'  checkbox.  This  option  allows  you  to  see  the  card  layout  that
depends on the condition field type when scrolling through the database records.
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Now choose  our  distinguish  color  for  the  card  that  in  our  example  is  what  will  define  visually  the
different departments.
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Now add a new layout for Sales and General departments. Click on the copy button twice. 

As  you  see  it  copies  our  previous  card  to  the  new  layout.  All  we  need  to  do  now  is  the  same
procedure we made for the Marketing layout.

Define database settings for each new layout.

Now use the navigation buttons and start scrolling through the database records.

As you can see,  now the setup of  the  card  is  finished,  connected  to  an  excel  database  and  with
three different layouts to define the different departments.

 But  this  is  an  example,  you  can  choose  as  many  layouts  as  you  want  and  set  your  own
conditions.
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4.2.4 - Script

 There are two kinds of scripts  in cardPresso,  one for each object  and one for the document.  In
this chapter we focus on the card document script.

This  is  an  advanced  user  area,  where  you  can  program  actions  and  procedures  in  ECMEAScript
language in order to define settings or update your object.

 This drop-menu allows you to define when the actions or procedures must take place.

 And in the space bellow you can write your lines of code.

 To see the log of your program output, change tab bellow.
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4.3 - Document Objects

 These objects  are the most  important  features  in your  card  document  creation  process.  There
are two major types of objects, static and dynamic. 

The first class refers  to objects  that  will  never change along the creation or data input  process,  like
backgrounds and shapes, for instance. 

The second ones can be static  or variable.  Static  as  a simple keyboard  input  text  line  can  be  but
when  we  connect  the  same  text  line  to  a  database  and  make  it  change  while  browsing  through
several records it makes it a variable object according to its data source.

The  objects  can  be  placed  throughout  the  card  space,  in  the  front  and  back  side.  And  can  be
arranged as you wish in order to overcome your creation needs.

There  are  also  a  set  of  specific  settings  to  each  object  that  you  can  use  according  to  your  own
specifications, like color, size, source, among many others.  

New 

Line

New

Rectangle

New 

Circle

New 

Shape

New 

Text

Print 

Counter

Print 

Date

New 1D

Barcode

New 2D

Barcode

Browse

Image

Acquire 

Image

New 

Image

Database

Image

Signature

4.3.01 - Line

 This  object  is  a simple straight  line,  but  still  has  some  features  that  you  can  setup.  You  can
choose between five different kinds of lines and a custom one
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 Solid Line: Is a plain line.

 Dash Line: Dashes separated by a few pixels.

 Dot Line: Dots separated by a few pixels.

 DashDot Line: Alternate dots and dashes.

 DashDotDot LIne: One dash, two dots, one dash, two dots.

 The Custom Line is a line that you can define as you wish. By clicking on the 'advance ' button
you can set additional parameters like offset and pattern.

 Line width: varies between 0.1 to 10 mm.

 You can, also, change the color by clicking in one of the colored squares, acquire any color you
have on your screen using the dropper or use the advance color settings by  clicking  on  the  'More
Colors' button.

 By clicking on the 'advance' button you have access to settings that allows you to change the
shape of your line. All you have to do is to write the command on the line like shown bellow.
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 SquareCap: A square line end that  covers  the end point  and extends beyond it  by  half the line
width.

 FlatCap: A square line end that does not cover the end point of the line.

 RoundCap: A rounded line end.

 If you right click on the object a pop-up menu is shown allowing you to:

 Copy  -  Click  on  the  copy  option  or  use  the  shortcut  'CTRL-C'  to  copy  the  object  to  the
clipboard. 

 Delete - Deletes the selected object.

 Duplicate - Creates an exact copy of the object on the work space. 

 Send to Front - Send the object to the front of all objects on the work space.

 Send to Back - Send the object to the back of all objects on the work space.
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4.3.02 - Rectangle

 This object can be either a rectangle or a square, depending only of the side measures.

If you right click on the object a pop-up menu is shown allowing you to:

 Copy - Click on the copy option or use the shortcut 'CTRL-C' to copy the object to the clipboard.

 Delete - Deletes the selected object.

 Duplicate - Creates an exact copy of the object on the work space. 

 Send to Front - Send the object to the front of all objects on the work space.

 Send to Back - Send the object to the back of all objects on the work space.

 You can also setup a number of properties  and  settings  on  the  properties  tab,  on  the  right  of
your screen. All properties and settings will be addressed further on this manual.
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4.3.03 - Circle

 This object can be either a circle or an ellipse.  By moving the delimitation lines you can change
the appearance of the object.

If you right click on the object a pop-up menu is shown allowing you to:

 Copy - Click on the copy option or use the shortcut 'CTRL-C' to copy the object to the clipboard.

 Delete - Deletes the selected object.

 Duplicate - Creates an exact copy of the object on the work space. 

 Send to Front - Send the object to the front of all objects on the work space.

 Send to Back - Send the object to the back of all objects on the work space.

 You can also setup a number of properties  and  settings  on  the  properties  tab,  on  the  right  of
your screen. All properties and settings will be addressed further on this manual.
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4.3.04 - Shape

 This  object  can assume many different  shapes.  On the Shape Tab you have a dropdown menu
with several categories  of shapes.  Inside each  there  are  several  shapes  that  you  can  add  to  your
card.

 You can change the color by clicking in one of the colored squares,  acquire any color you have
on your screen using the dropper or use the advance color settings by  click  on  the  'More  Colors'
button.

If you right click on the object a pop-up menu is shown allowing you to:

 Copy  -  Click  on  the  copy  option  or  use  the  shortcut  'CTRL-C'  to  copy  the  object  to  the
clipboard.

 Delete - Deletes the selected object.

 Duplicate - Creates an exact copy of the object on the work space. 

 Send to Front - Send the object to the front of all objects on the work space.

 Send to Back - Send the object to the back of all objects on the work space.

 You can also setup a number of properties  and  settings  on  the  properties  tab,  on  the  right  of
your screen. All properties and settings will be addressed further on this manual.
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4.3.05 - Text

 The text  object  allows you to add text  to your card document.  After positioning the text  on the
card design area double-click on it to start typing your text. The default text format is a text box.

 There are three kinds of text objects: alphanumeric, numeric and Lists.

With the alphanumeric text objects, you can use a single line text  or a text  box,  that  allows you to
write more then one line of text.

The numeric type is divided in value, integer value and date/time.

There is also Lists and Database Lists, that are no more than a small list  with two fields,  one works
as an index and the other as the data that the object should display.

If you right click on the object a pop-up menu is shown allowing you to:

 Copy - Click on the copy option or use the shortcut 'CTRL-C' to copy the object to the clipboard.

 Delete - Deletes the selected object.

 Duplicate - Creates an exact copy of the object on the work space. 
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 Send to Front - Send the object to the front of all objects on the work space.

 Send to Back - Send the object to the back of all objects on the work space.

 You can also setup a number of properties  and  settings  on  the  properties  tab,  on  the  right  of
your screen. All properties and settings will be addressed further on this manual.
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4.3.06 - Print Counter

 The Print Counter object allows you to set a counter and print it on the card. 

You can set the update of the object to manual or automatic and interact with a database field.

 It also allows you to define the counter numeric format and values.

If you right click on the object a pop-up menu is shown allowing you to:

 Copy  -  Click  on  the  copy  option  or  use  the  shortcut  'CTRL-C'  to  copy  the  object  to  the
clipboard.

 Delete - Deletes the selected object.

 Duplicate - Creates an exact copy of the object on the work space. 

 Send to Front - Send the object to the front of all objects on the work space.

 Send to Back - Send the object to the back of all objects on the work space.

 You can also setup a number of properties  and  settings  on  the  properties  tab,  on  the  right  of
your screen. All properties and settings will be addressed further on this manual.
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4.3.07 - Print Date

 The Print Date object allows you to print on the card the current printing date and/or time. 

You can set the update of the object to manual or automatic and interact with a database field.

 It also allows you to define the date and time format.

If you right click on the object a pop-up menu is shown allowing you to:

 Copy  -  Click  on  the  copy  option  or  use  the  shortcut  'CTRL-C'  to  copy  the  object  to  the
clipboard.

 Delete - Deletes the selected object.

 Duplicate - Creates an exact copy of the object on the work space. 

 Send to Front - Send the object to the front of all objects on the work space.

 Send to Back - Send the object to the back of all objects on the work space.

 You can also setup a number of properties  and  settings  on  the  properties  tab,  on  the  right  of
your screen. All properties and settings will be addressed further on this manual.
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4.3.08 - 1D Barcode

 This  object  allows  you  to  create  a  barcode.  A  barcode  is  an  optical  machine-readable
representation of data relating to the object to which it is attached.

There are many different  barcodes types,  Code  128,  EAN-8,  UPC among  many  others.  Each  one
with different features and settings.

You can setup to see only the bars or complement it with readable data.

 You can also connect the object to a database field to become a dynamic readable source.

If you right click on the object a pop-up menu is shown allowing you to:

 Copy  -  Click  on  the  copy  option  or  use  the  shortcut  'CTRL+C'  to  copy  the  object  to  the
clipboard.

 Delete - Deletes the selected object.

 Duplicate - Creates an exact copy of the object on the work space. 

 Send to Front - Send the object to the front of all objects on the work space.

 Send to Back - Send the object to the back of all objects on the work space.

 You can also setup a number of properties  and  settings  on  the  properties  tab,  on  the  right  of
your screen. All properties and settings will be addressed further on this manual.
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4.3.09 - 2D Barcode

 This  object  allows  you  to  create  a  2D  barcode.  A  2D  barcode  is  also  an  optical  machine-
readable representation of data relating to the object  to  which  it  is  attached,  evolved   from  the  1D
barcode  into  rectangles,  dots,  hexagons  and  other  geometric  patterns  in  two  dimensions  (2D).
Although 2D systems use a variety of symbols, they are generally referred to as barcodes as well.

There are many different  2D barcodes types,  PDF417,  Datamatrix,  QR-Code between others.  Each
one with different characteristics.

 You can also connect the object to a database field to become a dynamic readable source.

 Please be aware that this object is only supported on XM and XL cardPresso editions.

 If you right click on the object a pop-up menu is shown allowing you to:

 Copy  -  Click  on  the  copy  option  or  use  the  shortcut  'CTRL+C'  to  copy  the  object  to  the
clipboard.

 Delete - Deletes the selected object.

 Duplicate - Creates an exact copy of the object on the work space. 

 Send to Front - Send the object to the front of all objects on the work space.

 Send to Back - Send the object to the back of all objects on the work space.

 You can also setup a number of properties  and  settings  on  the  properties  tab,  on  the  right  of
your screen. All properties and settings will be addressed further on this manual.
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4.3.10 - Image

 This object is a very important one, not only because it allows you to add and work  an image on
your card, but also allows you to transform that image into your card background.

An image can be add to your  card  from  any  source  available  like  a  scan  device,  camera,  disc  or
cloud and allows any kind of image, jpg, png and others.

With cardPresso you can transform that image as you want, changing color, light, size and many
other settings.

 Making  it  your  card  background  is  easy,  right  click  on  the  image  and  chose  'Set  as
Background' and your picture is adapted to your card size.

If you right click on the object a pop-up menu is shown allowing you to:

 Copy  -  Click  on  the  copy  option  or  use  the  shortcut  'CTRL+C'  to  copy  the  object  to  the
clipboard.

 Delete - Deletes the selected object.

 Duplicate - Creates an exact copy of the object on the work space. 

 Send to Front - Send the object to the front of all objects on the work space.

 Send to Back - Send the object to the back of all objects on the work space.

 Export Image - Allows you to export the image as a file to anywhere on your computer.

 Set As Background - Set the image as the background of your layout.

 You can also setup a number of properties  and  settings  on  the  properties  tab,  on  the  right  of
your screen. All properties and settings will be addressed further on this manual.
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4.3.11 - Signature

This object allows you to add a Signature on the card.

A Signature can be  added  from  Signature  Pad  devices  recognized  by  cardPresso,  which  are  the
WinTab, Wacom Bamboo & Topaz:

- SigLite LCD 1x5 - T-L460-HSB-R and T-LBK460-HSB-R
- SigLite LCD 4x3 - T-LBK750-BHSB-R
- SignatureGem LCD 1x5 - T-L462-HSB-R and T-LBK462-HSB-R
- SignatureGem LCD 4x3 - T-LBK755-BHSB-R and T-LBK755SE-BHSB-R
- SignatureGem LCD 4x5 – T-LBK766-BHSB-R

The Signature can also be saved to a Database as an image.

If you right click on the object a pop-up menu is shown allowing you to:

 Copy  -  Click  on  the  copy  option  or  use  the  shortcut  'CTRL+C'  to  copy  the  object  to  the
clipboard.

 Delete - Deletes the selected object.

 Duplicate - Creates an exact copy of the object on the work space. 

 Send to Front - Send the object to the front of all objects on the work space.

 Send to Back - Send the object to the back of all objects on the work space.

 Export Image - Allows you to export the image as a file to anywhere on your computer.

 Set As Background - Set the image as the background of your layout.

 You can also setup a number of properties  and  settings  on  the  properties  tab,  on  the  right  of
your screen. All properties and settings will be addressed further on this manual.
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4.4 - Objects Properties

 cardPresso has a properties space, shown on the right side of your screen and you can display
it as a set of tabs or as a tree or accordion set, as pictured below. To change,  just  right click on an
empty space on the tab and check one of the options.

These tabs change depending on the object we are dealing on the working area and as  you will  see
further on this manual.

 Script, Layouts, Clipart and Background are the four basic  tabs already refered on the 'Card
Document  Settings'  chapter.  These  tabs  are  shown  after  you  chose  your  card  model  and  are
previously referred to in this manual.
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4.4.1 - Item

 The Item tab allows you to define the ID, Group and visibility of an object.

 Object ID - Defining the object ID not only helps you organizing data on your document, but also
gives you an easier object identification and helps you on encoding operations.

When  manipulating  a  database  you  can  use  an  ID  to  identify  objects  that  will  help  you  while
programming a script.

The options settings allows you to:

 Design  Not  Allowed  -  Check  the  'Design  not  allowed'  box  protecting  the  object  from  being
changed, but only  the graphical appearance and drag&drop position,  not  the content.  This  option is
applied to all objects but background.

 Print - Lets you set if an item should be printed (Yes), if an item should not  be printed (No),  if it
should only  be printed when it  contains  data (Only when has data),  or if it  should only  be printed
when the data currently  displayed in the  item  is  valid  for  the  type  of  item  (Only  when  has valid
data).

 Opacity - You can also define the opacity level of the object by scrolling the opacity button, from
100%, the default position to 0%.

 Encoding - For items that hold data to be encoded, like magnetic tracks,  this  option allows you
to manually set if the date should be encded (Yes),  should n't  be encoded (No) or to only  encode if
the item currently has data when being encoding (Only when has data).
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4.4.2 - Position

 In this tab you can set the position manually or check the real-time position when moving and/or
resizing the object directly in the card design area. 

The same properties  apply  to the  objects  dimensions,  allowing  you  to  manually  change  the  width
and height of the object with a higher precision level.
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4.4.3 - Shape

 This option allows you to change the visual shape properties of an object, setting it  up the visible
area of that object with three different formats, circle, rectangle or round rectangle.

It's like hiding the image behind a layer with a hole in the middle,  and the shape of that  hole define
the visible part  of our image,  as  shown below. For instance if you chose a circle shape the area of
the photo that is sitting directly above the circle content area now remains completely visible.

 To define the clipping area and format all you have to do is drag the image boundaries.
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4.4.4 - Rotation

 In this tab you can rotate or define a rotation angle to your object... Or you can select  more than
one object and apply a rotation to all the selected objects at the same time.

 cardPresso  has  quick  rotation  buttons  for  the  most  common  rotations,  0,  90,  180  and  270
degrees rotation.  You may also rotate the object  in  increments  and  /or  decrements  of  45  degrees
(also available using the shortcut 'Backspace').

 If you wish to apply a more specific rotation use the edit box available for those situations

 Or turn the round button to the desired angle, updating at the same time the angle box value.

 All these changes are seen in real-time on the object.

4.4.5 - Outline

 Outline allows you to chose between five different types of predefined lines and a custom one.
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 Solid Line: Is a plain line.

 Dash Line: Dashes separated by a few pixels.

 Dot Line: Dots separated by a few pixels.

 DashDot Line: Alternate dots and dashes.

 DashDotDot LIne: One dash, two dots, one dash, two dots.

 The Custom Line  is  a line that  you can define as  you wish and if click  on the advance  button
besides the normal advanced parameters you are allowed to set offset and pattern parameters.

 Line width is one of the settings that you can change from 0.1mm to 10mm

 You can also change the color by clicking in one of the colored squares,  acquire any color you
have  on  your  screen  using  the  dropper  or  use  the  advance  color  settings  by  click  on  the  'More
Colors' button.

 Clicking  on  the  'advance'  button  you  have  access  to  a  serial  of  settings  that  allows  you  to
change the shape of your line.  All  you have to do is  to  write  the  command  on  the  line  like  shown
bellow.
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 SquareCap: A square line end that  covers  the end point  and extends beyond it  by  half the line
width.

 FlatCap: A square line end that does not cover the end point of the line.

 RoundCap: A rounded line end.

4.4.6 - Fill

 Define the fill color you want to see applied on your object, in case of lines,  rectangles  or circles
it will change the color of the object, on all other cases it will change the background color.

 No fill: No color is applied to the object.  This  option is  extremely  handy when placing Text  over
other objects.

 Solid  Fill:  Fill  the  area  with  only  one  color  and  you  can  define  the  color  using  the  standard
pallet, the dropper or using the advanced pallet within the "More Colors" button.
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 Gradient Fill:  Allows you to pick  a second color and  make  a  gradient  effect  with  both  colors
and define both colors  using standard pallet,  the dropper or  clicking  in  "More  Colors"  button  using
the advanced pallet.

 Dropper:  In  case  of  using  the  dropper  you  can  select  any  color,  even  outside  the  program
window, like shown on the first picture below. After that  the color is  applied to the object  and added
to the color pallet as you can see on the second picture.

 More Colors: Gives you access to an advanced color pallet.

 Basic Pallet Color Theme: To chose a theme for your basic pallet color use the drop menu like
shown on the picture bellow and the theme is automatically applied to the basic pallet color.
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 In this  example choosing Rainbow option will  apply  to the basic  color pallet  only  colors  related
with Rainbow theme.

 Unusual Color: In case you want to add an unusual color,  you have two ways to do it,  you can
drag the crosshair through the panel or input directly the color values on the boxes.

 After that, the new color is added to the basic color pallet.    

4.4.7 - Font

 When you select the 'Font' tab, a number of tools allows you to define the font of your object. 
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 First  you have the 'Font Family' where you can chose the font  type,  all  fonts  that  you have in
Windows or on your OSx are displayed here.

 Point  Size  -  Allows  you  to  define  the  font  size,  if  you  check  on  the  checkbox  the  size  is
determined by  the space available between boundaries,  to change just  drag and drop the  selection
handles.

 Color - Chose the font color.

 Typeface allows you to define more font settings that affect the whole Textbox, like:

  

 You can also wrap the sentence on your object by checking the 'Word Wrap' checkbox.
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 With 'Render as HTML' checked,  you can use some HTML codes in your text  to  change  the
'Typeface' in parts of it, instead of the whole Textbox. 

 

 Text between <u> </u> will be Underlined.

 Text between <i> </i>  will be in Italic.

 Text between <b> </b> will be in Bold.

 The <p> starts a new paragraph.
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4.4.8 - Barcode

 The bar code properties allows you to define some properties  depending on the type of barcode
you want to use. There are two major types of barcodes the 1D and 2D, illustrated bellow.

Let's start by making a general introduction, to the most common properties  of barcodes,  referenced
on cardPresso: 

 Type:  Chose the type of barcode you  wish  to  use,  keeping  in  mind  that  in  some  cases  your
choice may change other properties range of values.

 Color: Define your barcode color.

 Human Readable:  Defines if the  readable  data,  alphanumeric  characters,  is  imprinted  or  not
(only 1D barcode).

 Font: Defines the font of the readable data (only 1D barcode).

 Other properties  and definitions are specific  to each different  type  of  barcode,  therefore  will  be
addressed further on this manual.



cardPresso Manual84

© 2014 cardPresso, Lda

4.4.9 - Image

 You can acquire images from any source available,  from disk,  from database,  from a camera or
even from a scanner. 

 After you select an image and apply it  to your working area,  you have access to a new tab,  the
image tab. On this tab you can change a set of properties as:

 Keep Ratio: Allows you to adapt the image to your object boundaries or keep the image ratio.

 Reinforce Black: This option forces the usage of Resin K on the black in the image.

 Flip Horizontal: This  option reverses the active object  horizontally,  that  is,  from left  to right.  It
leaves the dimensions of the object and the pixel information unchanged. It looks as if the image has
been reflected along the central vertical axis of the object.

 Flip  Vertical:  This  option  reverses  the  active  object  vertically,  that  is,  from  top  to  bottom.  It
leaves the dimensions of the object and the pixel information unchanged. It looks as if the image has
been reflected along the central horizontal axis of the object.

 Grayscale: Applies grayscale on the image in which the value of each pixel is  a single sample,
that is, it carries only intensity information. Images of this  sort,  are composed exclusively  of shades
of gray, varying from black at the weakest intensity to white at the strongest.

 Chromakey Effect: Turn the chromakey effect on and off in which a color range in the top layer
is made transparent, revealing another image behind.

 Color: Allows you to choose  the  color  range  on  which  the  effect  will  act.  Use  the  dropper  to
chose any color on the image.

 Tolerance  Level  -  Allows  you  to  change  the  tolerance  level  of  the  effect.  The  bigger  the
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tolerance, the larger the range of colors affected by the effect.

 Effect area  -  Select  the  area  of  the  image  affected  by  the  effect,  if  all  image  or  only  on  the
frame.

 If you double click on the image the Image Editor opens with more edition tools.
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4.4.10 - Source

 The Source Tab allows you to define the origin of the object  and parameterize that  same object.
In cardPresso you have two major object classes, the images and all the text objects.

 On text objects and barcodes the source can be a print  counter,  a print  date,  a keyboard input,
database or item link.

On image objects and signatures the source can be the disk, a camera or scanner, the image editor,
a database field or an item link. 

On the  next chapters we  will  show  you how  to use  them and how  to define  them, in sum:
how easy it is to manipulate any of the sources or its properties.
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4.4.10.1 - Text & Barcode

 When you have a text  or barcode object  selected you can use the Source Tab to set  the input
options for the object.

 On this tab you will define what kind of object it is, how it is  updated,  under what  condition it  will
be updated, when it will be updated and the final result.
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4.4.10.1.1  4.4.10.1.1 - Print Counter

 This feature allows you to add a print  counter to your card.  It  can be updated automatically  and
saved with your card file, thus keeping the counter status. You can also define values, justify and set
the number of digits of the counter as explained further on this manual.

When a text object  is  selected you can go to the Source Tab and,  on the drop down menu on top,
choose the Print Counter option or click on the 'Print Counter' button on the design toolbar.

 You can update your counter in five different situations:

 When Item Clicked - When you double-click  the object  it  will  update the counter according to
all the settings.

 When Load Document - Every time the card document is opened.

 Before Print - Count the number of times you send a print  order and update the counter before
the printing procedure.

 Before  Print Card - Count  the  number  of  cards  you're  going  to  print  and  update  the  counter
before each card is printed.
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 After Print Card - Count  the number of cards  you printed and update the counter after printing
each card.

 And set the following properties:

 Save  with Document - Save the settings and counters  with the document so you don't  loose
any data.

 Minimum Value - Defines the counter minimum value in case of negative incrementation.

 Maximum Value - Defines the counter maximum value in case of positive incrementation.

 Restart Value - Is the value assumed by the counter when it reaches the maximum or minimum
values. (Min Value < Restart Value < Max Value)

 Increment Value - Defines the incrementation value, it can be positive or negative.

 Current Value - Shows the current value.

 Justified with Zeros - Justify with zeros until the desired number of digits.

 Number of Digits - Defines the number of digits used in the counter, you can justify with zeros.

 Font Auto Adjust - Automatically adjust the font size, but only if font point size is set to auto.

 Concatenation - Allows you to  add  a  prefix  or  suffix  to  your  counter  value.  If  you  don't  want
these to be printed check the Ignore on print check box.
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4.4.10.1.2  4.4.10.1.2 - Print Date

 This  feature allows you to add a date object  to your card.  It  can be updated  automatically  and
saved with your card file,  thus keeping the date status.  You can also format  the  date  and  time  as
explained further on this manual.

When a text object  is  selected you can go to the Source Tab and,  on the drop down menu on top,
choose the Print Date option or click on the 'Print Date' button on the design toolbar.

 You can update your date/time in four different situations.

 When Item Clicked - When you double-click the object it will update the date and time.

 When Load Document - Every  time  you  open  the  document  it  will  automatically  update  the
date object. 

 Before  Print  -  Update  the  counter  before  the  printing  procedure  starts  and  all  the  cards  are
printed with the same date and time.

 Before Print Card - Update date and time before printing each card.
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 And set the following properties:

 Save with Document -  Save the settings and date/time of the last  printing procedure with the
document so you don't lose any data.

 Format - You can format  the date using one of the preset  formats  available thru the drop down
menu or by  creating your own format  by  clicking on the pointed button  and  then  write  it  according
with the legend bellow.

 Font Auto Adjust - Automatically adjust the font size, but only if font point size is auto.

 Concatenation - Allows you to add a prefix or a suffix to your date and it can be printable,  to do
that just check on the check-box.

4.4.10.1.3  4.4.10.1.3 - Keyboard Input

 This setting allows you add an object  to your card that  is  updated by  keyboard input.  It  can be
updated automatically,  saved with your card file.  You can also choose the data type like explained
further on this manual.

When a text  object  is  selected,  you can go to the Source Tab and on the dropdown menu,  on top,
chose Keyboard Input option.

 Title - You can give a name to your object, it will make it easier for further identification.

 You can update the object in six different situations.
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 When Item Clicked - When you double-click on top of the object it will open an input  window to
update.

 On  EditView  -  This  setting,  when  chosen,  allows  you  add  a  new  field  to  a  small  internal
database, as you'll see further on this manual.

 When Load Document - When the card document is loaded this object is updated.

 Before Print - After the print order and before start  printing,  it  will  open an input  data window in
order to allow you to update the object, after that it will  not  be update again until  next  print  order,  on
the example below was date field.

 Before  Print Card - Before print  each card,  it  will  open an input  data window in order to  allow
you to update the object, on the example below was date field.

 After Print Card - After print  each card,  it  will  open  an  input  window in  order  to  allow you  to
update the object for the next card, on the example below was date field.
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 Save with Document Save on your card document the last object update.

 Data Type On this setting you can define what kind of data your object can hold.

 Text Line - Allows you to input text information in one line.

 Data Length - Defines the length of your text line (maximum of 128 characters).

 Input Mask - The mask consists of a string of mask characters  and separators.  You can define
your object input guide by choosing the mask or the Validation Rules, when both the mask prevails.

Character Meaning
A ASCII alphabetic character required. A-Z, a-z.
a ASCII alphabetic character permitted but not required.
N ASCII alphanumeric character required. A-Z, a-z, 0-9.
n ASCII alphanumeric character permitted but not required.
X Any character required.
x Any character permitted but not required.
9 ASCII digit required. 0-9.
0 ASCII digit permitted but not required.
D ASCII digit required. 1-9.
d ASCII digit permitted but not required (1-9).
# ASCII digit or plus/minus sign permitted but not required.
H Hexadecimal character required. A-F, a-f, 0-9.
h Hexadecimal character permitted but not required.
B Binary character required. 0-1.
b Binary character permitted but not required.
> All following alphabetic characters are uppercased.
< All following alphabetic characters are lowercased.
! Switch off case conversion.
\ Use \ to escape the special characters listed above to use them as separators.
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 Examples:

Mask Notes
000.000.000.000;_ IP address; blanks are _.
HH:HH:HH:HH:HH:HH;_ MAC address
0000-00-00 ISO Date; blanks are space
>AAAAA-AAAAA-AAAAA-
AAAA-AAAAA;#

License number; blanks are - and all (alphabetic) characters are
converted to uppercase.

 Validation Rules - Validation Rules  are built  up from expressions,  quantifiers,  and assertions.
The simplest expression is  a character,  e.g.  x  or 5.  An expression can also be a set  of characters
enclosed in square brackets. [ABCD] will match an A or a B or a C or a D.  We can write this  same
expression as [A-D], and an expression to match any capital letter in the English alphabet  is  written
as [A-Z].

A  quantifier  specifies  the  number  of  occurrences  of  an  expression  that  must  be  matched.  x{1,1}
means match one and only one x. x{1,5} means match a sequence of x  characters  that  contains  at
least one x but no more than five.

Note that  in general Validation Rules  cannot  be used  to  check  for  balanced  brackets  or  tags.  For
example,  a Validation Rule can be written to match an opening HTML <b> and  its  closing  </b>,  if
the <b> tags are not nested, but if the <b> tags are nested, that same Validation Rule will  match an
opening <b> tag with the wrong closing </b>. For the fragment <b>bold <b>bolder</b></b>,  the first
<b> would be matched with the first  </b>,  which  is  not  correct.  However,  it  is  possible  to  write  a
Validation Rule that  will  match nested brackets  or tags correctly,  but  only  if the number  of  nesting
levels is fixed and known. If the number of nesting levels  is  not  fixed and known, it  is  impossible to
write a Validation Rule that will not fail.

Suppose we want  a  Validation  Rule  to  match  integers  in  the  range  0  to  99.  At  least  one  digit  is
required, so we start with the expression [0-9]{1,1},  which matches a single digit  exactly  once.  This
Validation  Rule  matches  integers  in  the  range  0  to  9.  To  match  integers  up  to  99,  increase  the
maximum number of occurrences to 2,  so  the  Validation  Rule  becomes  [0-9]{1,2}.  This  Validation
Rule satisfies the original requirement to match integers from 0 to 99,  but  it  will  also match integers
that  occur in the middle of strings.  If we want  the matched integer to be the whole string,  we must
use the anchor assertions,  ̂(caret) and $ (dollar). When ^ is  the first  character in a Validation Rule,
it  means  the  Validation  Rule  must  match  from  the  beginning  of  the  string.  When  $  is  the  last
character of the Validation Rule,  it  means the Validation Rule must  match to the end of the  string.
The  Validation  Rule  becomes  [̂0-9]{1,2}$.  Note  that  assertions,  e.g.  ^  and  $,  do  not  match
characters but locations in the string.

If you have seen Validation Rules described elsewhere, they may have looked different from the ones
shown here.  This  is  because  some  sets  of  characters  and  some  quantifiers  are  so  common  that
they have been given special symbols  to represent  them. [0-9]  can be replaced with the symbol \d.
The quantifier to match exactly one occurrence, {1,1}, can be replaced with the expression itself,  i.e.
x{1,1} is the same as x. So our 0 to 99 matcher could be written as  \̂d{1,2}$.  It  can also be written
\̂d\d{0,1}$,  i.e.  From the start  of the string,  match a digit,  followed immediately  by  0 or 1 digits.  In

practice,  it  would  be  written  as  \̂d\d?$.  The  ?  is  shorthand  for  the  quantifier  {0,1},  i.e.  0  or  1
occurrences.  ?  makes  an  expression  optional.  The  Validation  Rule  \̂d\d?$  means  From  the
beginning  of  the  string,  match  one  digit,  followed  immediately  by  0  or  1  more  digit,  followed
immediately by end of string.

To write a Validation Rule that matches one of the words 'mail' or 'letter' or 'correspondence' but  does
not match words that contain these words,  e.g.,  'email',  'mailman',  'mailer',  and 'letterbox',  start  with
a Validation Rule that matches 'mail'.  Expressed fully,  the Validation Rule is  m{1,1}a{1,1}i{1,1}l{1,1},
but  because  a  character  expression  is  automatically  quantified  by  {1,1},  we  can  simplify  the
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Validation Rule to mail, i.e., an 'm' followed by an 'a' followed by an 'i' followed by an 'l'.  Now we can
use the vertical bar |,  which  means  or,  to  include  the  other  two  words,  so  our  Validation  Rule  for
matching  any  of  the  three  words  becomes  mail|letter|correspondence.  Match  'mail'  or  'letter'  or
'correspondence'. While this Validation Rule will  match one of the three words we want  to match,  it
will  also  match  words  we  don't  want  to  match,  e.g.,  'email'.  To  prevent  the  Validation  Rule  from
matching unwanted words, we must  tell  it  to begin and end the match at  word boundaries.  First  we
enclose  our  Validation  Rule  in  parentheses,  (mail|letter|correspondence).  Parentheses  group
expressions  together,  and  they  identify  a  part  of  the  Validation  Rule  that  we  wish  to  capture.
Enclosing  the  expression  in  parentheses  allows  us  to  use  it  as  a  component  in  more  complex
Validation Rules.  It  also allows us  to examine which of the  three  words  was  actually  matched.  To
force the match to begin and  end  on  word  boundaries,  we  enclose  the  Validation  Rule  in  \b  word
boundary assertions: \b(mail|letter|correspondence)\b. Now the Validation Rule means: Match a word
boundary,  followed  by  the  Validation  Rule  in  parentheses,  followed  by  a  word  boundary.  The  \b
assertion matches a position in the Validation Rule,  not  a character.  A word boundary  is  any  non-
word character, e.g., a space, newline, or the beginning or ending of a string.

Characters and Abbreviations for Sets of Characters

Element Meaning
c A character represents itself unless it has a special regexp meaning. e.g. c

matches the character c.
\c A character that follows a backslash matches the character itself, except as

specified below. e.g., To match a literal caret at the beginning of a string,
write \ .̂

\a Matches the ASCII bell (BEL, 0x07).
\f Matches the ASCII form feed (FF, 0x0C).
\n Matches the ASCII line feed (LF, 0x0A, Unix newline).
\r Matches the ASCII carriage return (CR, 0x0D).
\t Matches the ASCII horizontal tab (HT, 0x09).
\v Matches the ASCII vertical tab (VT, 0x0B).
\xhhhh Matches the Unicode character corresponding to the hexadecimal number hhhh

(between 0x0000 and 0xFFFF).
\0ooo (i.e., \zero
ooo)

matches the ASCII/Latin1 character for the octal number ooo (between 0 and
0377).

. (dot) Matches any character (including newline).
\d Matches a digit (QChar::isDigit()).
\D Matches a non-digit.
\s Matches a whitespace character (QChar::isSpace()).
\S Matches a non-whitespace character.
\w Matches a word character (QChar::isLetterOrNumber(), QChar::isMark(), or '_').
\W Matches a non-word character.
\n The n-th backreference, e.g. \1, \2, etc.

 Text Box  - The multiline  text  box  is  used  only  if  more  than  one  line  of  input  is  required  and
allows  you  to  input  text  information.  To  input  a  new  line  the  user  must  press  CTRL+Enter.  By
pressing only the Enter key will close the text box.

 Columns - Define the number of columns of you text box (max: 128)
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 Rows - Define the number of rows of you text box (max: 128)

 Value - Defines the object as a numeric value.

 Minimum Value - Defines the minimum value reachable, normally used to countdown.

 Maximum Value - Defines the maximum value.

 Step Value - Define step value when updated, use negative value for countdown.

 Decimals - Defines the number of decimal places.

 Alignment - Set horizontal alignment

 Prefix - Defines character set that precedes the number.

 Suffix - Defines character set shown after the number.

 Special  Value  - Is  the value the object  will  assume  after  reaching  the  maximum  or  minimum
values.

 Integer Value - Allows you to write any integer value in one line box.

 Maximum Value - Defines the maximum value.

 Step Value - Define step value when updated, use negative value for countdown.

 Alignment - Set horizontal alignment

 Prefix - Defines character set that precedes the number.

 Suffix - Defines character set shown after the number.

 Special  Value  - Is  the value the object  will  assume  after  reaching  the  maximum  or  minimum
values.

 Date - Allows you to write any date value in single line box.
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 Minimum Date - Set the minimum value to date to avoids backdating. 

 Maximum Date - Set the maximum value to date to avoids introducing later dates.

 Alignment - Allows you to align text date inside object.

 Calendar Pop-up - Every time you change settings on date field it  pops up a calendar to easy
date manipulation.

 Date Format - Helps you set a date value format, you have some predefined.

 Time - Allows you to write any time value in one line box.

 Minimum Time - Set the minimum value to time to avoids backtiming

 Maximum Time - Set the maximum value to date to avoids introducing later time.

 Alignment - Allows you to align time text inside object.

 Time Format - Helps you set a time value format, you have some predefined.
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 Date and Time - Allows you to write any date and time value in one line box.

 Minimum Date - Set the minimum value to date to avoids backdating.

 Maximum Date - Set the maximum value to date to avoids introducing later dates.

 Minimum Time - Set the minimum value to time to avoids backtiming

 Maximum Time - Set the maximum value to date to avoids introducing later time.

 Alignment - Allows you to align text date inside object.

 Calendar Pop-up - Every time you change settings on date field it  pops up a calendar to easy
date manipulation.

 Date  and  Time  Format  -  Helps  you  set  a  date  and  time  value  format,  you  have  some
predefined.

 List - Allows you to create a list, composed by two columns, the first is an index column and the
second is the data column. 
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 Database List - Allows you to create a combobox to select the update data to your object.  This
only works if connected to a SQL database. 

 The SQL Select  statement  is  part  of the SQL code and bellow we describe some examples  in
how to use that code, specially how to use the select statement.     

SELECT column_name(s)
FROM table_name

 Lets  consider  the  example  bellow,  from  our  internal  database,  where  we  select  the  position,
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extension and salary fields, from the employee database.  This  is  the first  step,  the second is  to set
a condition, only consider the records with the field salary with a value lower than 35000.
Now the selection is made and the condition is set.

 User Column - Here you define what column will  be listed on the combo box,  as  a reference to
the Data Column.

 Data  Column - Define to wish column belong the data that  will  be shown on the database  list
object.

 Limit Rows - Setup the maximum rows to be listed on the combo box, to a maximum of 99.

 After we define the User Column as 0 and the Data Column as 1,  we  define  the  column  to  be
listed as the first (the count starts from zero) and the Data Column as the second and the result  will
be as shown bellow.



Chapter 4. Design 101

© 2014 cardPresso, Lda

On your combo box is only listed the position field records (User Column 0) that matches the
condition (salary<35000). And when the position Mail Clerk is selected the object assume the
extension field record of the selected position 6261.   

 Font Auto Adjust - Automatically adjust the font size, but only if font point size is auto.

 Concatenation - Allows you to add a prefix or a suffix to your date and it can be printable,  to do
that just check on the check-box.
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4.4.10.1.4  4.4.10.1.4 - Database

 There  are  two  ways  to  add  an  object  linked  to  a  database  to  the  card  document.  Open  a
database and drag and drop the fields  like explained further on this  manual or create the object  and
then connect it to a database. We will address the last option now.

After creating an object go to the Source Tab and select the Database option.

 After you have chosen this option your tab changes.

  And  the  next  step  is  to  click  on  the  button  'Connect  to  a  Database'.  The  Database
Connection Wizard will start allowing you to connect to any database you want.

After  the  database  is  opened,  by  default  the  object  will  be  connected  to  the  first  table  and  first
column of your database, like shown on picture bellow. All you have to do now is define the table and
column that you want your object to be linked to.

 Font Auto Adjust - When you have defined a size for your object  it  allows you to choose if you
want cardPresso to automatically adjust the font size.
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 Concatenation  -  Allows  you  to  add  a  prefix  or  a  suffix  to  your  data  and  print  it.  While  in
datatabase mode you can concatenate up to four columns on the same  object  and  define  a  prefix
separator if needed.
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As you can see the first  element  on our object  is  'Employee  ID' the one connected by  default  and
the two others we choose to merge in our object, the first and last names.
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4.4.10.1.5  4.4.10.1.5 - Item Link

 This  option  allows  you  to  connect  an  object  to  another,  assuming  the  same  values  with
automatic update.

When you chose this option your tab changes,  allowing you to chose an object  to link,  showing on
the list  all  objects  that  are on  the  card  space  and  which  is  possible  to  connect,  in  this  particular
case we have a card with three other objects.

 When connected the object will assume the linked object value and every time it is updated so is
our object.



cardPresso Manual106

© 2014 cardPresso, Lda

4.4.10.2 - Image & Signature

 When you select an image object  a new tab is  added to properties  tabs,  the Image Tab,  where
you will  be able  to  define  your  image  settings.  But  the  source  tab  also  changes,  allowing  you  to
define the source settings of your image file.

4.4.10.2.1  4.4.10.2.1 - From Disk

 This  option sets  the image source as  the disk.  When the object  is  updated the browser opens
allowing you to pick an image from disk.

To open an object from disk the procedure is simple, just click on the 'Browse Image' button, add a
picture object to your card and a window will open allowing you to browse for your file.

Like shown on the picture bellow:
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 Title  - Here you can give  a  name/title  to  your  image,  it  will  be  easier  for  you  to  identify  your
object later in further operations.

 Source  - Opens a dropdown list  with all  cameras or scanners  that  are installed  on  your  pc  or
mac.

 Updated - Your object is updated in five different situations:
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 When  Item  Double-Clicked  -  When  you  double-click  on  top  of  the  object  it  will  open  the
interface related to the source you have chosen.

 When Load Document - Every time you open the card document.

 Before  Print - Before the printing procedure it  will  open the interface related to the source you
have chosen.

 Before  Print Card - Before each time a card is  printed it  will  open the interface related  to  the
source you have chosen.

 After Print Card - After printing each card it  will  open  the  interface  related  to  the  source  you
have chosen.

 Save with Document - Save the image with the document so you don't  loose any data,  but  in
the other hand if you don't want to keep the image for a smaller card document just chose 'No'.

 Format - The image can have a pre-established format, like shown on the image above,  adapting
the image to it or a free format, allowing you to keep the image source format.

 Face  Detection  -  When  you  chose  yes,  after  the  image  as  been  acquired  the  image  editor
opens, allowing you to chose the face detection option.

 Open Image  Editor -  You  can  open  the  editor  every  time  the  image  is  updated  (yes),  never
open the editor (no) or open the editor only when an error is detected (Only when error).

4.4.10.2.2  4.4.10.2.2 - From Camera or Scanner

 After you add an image to your card,  the first  thing that  opens is  the image editor,  but  you can
change your image source any time you want and a camera or scanner is one of your options.



Chapter 4. Design 109

© 2014 cardPresso, Lda

After chose this option your source pad changes allowing setup the camera or scanner options.

 Title  - Here you can give  a  name/title  to  your  image,  it  will  be  easier  for  you  to  identify  your
object later in further operations.

 Source  - Opens a dropdown list  with all  cameras or scanners  that  are installed  on  your  pc  or
mac.

 Updated - Your object is updated in five different situations:

 When Item Double-Clicked -  When  you  double-click  on  the  object  it  will  open  the  interface
related to the source you have chosen.

 When Load Document - Every time you open the card document.

 Before  Print - Before the printing procedure it  will  open the interface related to the source you
have chosen.

 Before  Print Card - Before each time a card is  printed it  will  open the interface related  to  the
source you have chosen.

 After Print Card - After printing each card it  will  open  the  interface  related  to  the  source  you
have chosen.

 Save with Document - Save the image with the document so you don't  loose any data,  but  in
the other hand if you don't want to keep the image for a smaller card document just chose 'No'.
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 Format - The image can have a pre-established format, like shown on the image above,  adapting
the image to it or a free format, allowing you to keep the image source format.

 Face  Detection  -  When  you  chose  yes,  after  the  image  as  been  acquired  the  image  editor
opens, allowing you to chose the face detection option.

 Open Image  Editor -  You  can  open  the  editor  every  time  the  image  is  updated  (yes),  never
open the editor (no) or open the editor only when an error is detected (Only when error).
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4.4.10.2.3  4.4.10.2.3 - From Signature Pad

 Signature pad is a signature acquisition device,  cardPresso work  essencial with two kinds,  the
Topaz or any device that work with the WinTab drivers.  

The acquisition procedure is simple, after click on the 'Signature' button and add the signature
object to the card a list will pop-up to allow you to chose the device in case of the Topaz, like shown
bellow.

After choosing  the device the interface window will show and wait for you to add the signature to the
device like in the pictures bellow:

The Topaz device also allows you to have templates for the signature frame. The Wintab drive have a
track pressure setting that according with the pressure made by the pen makes the line thinner or
thicker

Like any other image object, cardPresso allows you to use an existing object, all you have to do is
to click on the object and change the source to 'From Signature Pad' and starts the procedure of
signature acquisition.

 Source - Opens a dropdown list with all signature devices that are installed on your computer.
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 Updated - Your object is updated in five different situations:

 When Item Double-Clicked -  When  you  double-click  on  the  object  it  will  open  the  interface
related to the source you have chosen.

 When Load Document - Every time you open the card document.

 Before  Print - Before the printing procedure it  will  open the interface related to the source you
have chosen.

 Before  Print Card - Before each time a card is  printed it  will  open the interface related  to  the
source you have chosen.

 After Print Card - After printing each card it  will  open  the  interface  related  to  the  source  you
have chosen.

 Save with Document - Save the signature image with document  so you don't  loose any data,
but in the other hand if you don't want to keep the image for a smaller card document just chose 'No'.

 Format - The image can have a pre-established format, like shown on the image above,  adapting
the image to it or a free format, allowing you to keep the image source format.



Chapter 4. Design 113

© 2014 cardPresso, Lda

4.4.10.2.4  4.4.10.2.4 - From Image Editor

 The Image Editor brings you new tools for image edition, there are many ways to open the image
editor, but to acquisition only one, open an image object and then change the source to 'From 

On the tool bar you can set this settings on your image:

 Rotate  clockwise  -  Is  the  circular  motion  is  one  that  proceeds  in  the  same  direction  as  a
clock's hands: from the top to the right, then down and then to the left, and back up to the top.

 Rotate anti-clockwise - Is the circular motion is  one that  proceeds in the opposite direction as
a clock's hands: from the top to the left, then down and then to the right, and back up to the top.

 Flip Horizontal - This  option reverses the active object  horizontally,  that  is,  from left  to right.  It
leaves the dimensions of the object and the pixel information unchanged. It looks as if the image has
been reflected along the central vertical axis of the object.

 Flip Vertical  - This  option  reverses  the  active  object  vertically,  that  is,  from  top  to  bottom.  It
leaves the dimensions of the object and the pixel information unchanged. It looks as if the image has
been reflected along the central horizontal axis of the object.

 Brightness  and  Contrast  -  The  Brightness/Contrast  adjustment  lets  you  make  simple
adjustments to the tonal range of an image. Moving the brightness slider to the right  increases tonal
values  and  expands  image  highlights,  to  the  left  decreases  values  and  expands  shadows.  The
contrast  slider expands or shrinks  the overall  range of tonal values in the image.  To  change  values
you can drag the slider to the left  or to the right  or setup manually  typing the values on the boxes.
The values can go from -128 to 128.

 Color Balance  - Is  the global adjustment  of the intensities  of  the  colors  (typically  red,  green,
and blue primary colors  or RGB system).  Changing the overall  mixture of colors  in an image and is
used for color correction and when you drag any of the sliders, you can see those corrections taking
place, adjustments are made to the color values RGB (on screen) or CMY (on printers).  The values
can go from -128 to 128.
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 Color  to  Grey  -  Apply  gray  scale  on  the  image  in  which  the  value  of  each  pixel  is  a  single
sample, that is, it carries only intensity information. Images of this sort, are composed exclusively  of
shades of gray, varying from black at the weakest intensity to white at the strongest.

 Color to Monochrome  - Not  a combine black  and white in a continuum  producing  a  range  of
shades of gray but really starkly contrasted black and white.

 Zoom In -  This tool allows you to obtain a larger image, or a closer view.

 Zoom Out - This tool allows you to obtain a smaller image, or a farther view.

 Zoom Auto - Reset image to its initial size.

 Export Image  - You can save the image as...  in many different  formats  like png,  jpg,  bmp, tiff
and others.

 Select Image  Acquisition Source  -  Allows  you  to  select  the  image  acquisition  source  from
any  device  that  is  connected  or  installed  on  your  pc.  It  may  appear  some  devices  that  are  not
connected but are installed.

 Image  Acquisition - This  tools  opens  the  interface  related  with  the  image  acquisition  source
you had chosen.

 Open Image File - Opens an image file from your system, including disk,  pen,  memory  card or
any other source.

 Select Image File Path - Allows you to chose your default image file path from all  that  you had
already used before on your document.

 Face Detection 

 Face Detection Setup 

 Undo - It erases the last change done to the document reverting it to an older state.

 Clear Image - Erases the image from Image Editor.

 Cut /  Crop - On cardPresso crop tool you don't  use the traditional handlers,  the visual area is
automatically resized to the image object boundaries,  to cut/crop the image all  you have to do is  to
drag or zoom in on the image and every thing that is on the blur area (gray  and black  squares) when
you  click  the  cut/crop  button,  goes  away.  And  the  image  is  automatically  adjusted  to  the  object
area. 

 Save Changes - Click on this button to accept the changes.

 Cancel - Click on this button to quit on the changes.
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4.4.10.2.5  4.4.10.2.5 - From Database

 cardPresso  allows  you  to  connect  an  image  object  to  a  database  image,  this  way  you  can
setup the object as you want and then connect to the database image adapting it to your object. 

The procedure is simple, first add a image object to your card change the source to 'From
Database'.

 If not connected to a database yet  click on the 'Connect to Database' button.

 The connection wizard will start

 After the connection is  made,  if there is  no image field,  the link  is  not  made and the list  stays
like the image bellow, empty.

If there is only one image field, the cardPresso recognize it and the link is automatic.

 If  more  then  one  then  a  list  will  show  you  the  options for  you  to  chose,  like  shown
bellow.

  DATABASE
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 If you add a field image, please don't forget to refresh the database.

4.4.10.2.6  4.4.10.2.6 - Item Link

 This  option allows you to connect  (link) one object  to another object,  assuming the same  data
values with automatic update.

When you choose this option your tab changes allowing you to chose an object to link, showing on
the list all objects that are on the card document that you can connect to,

 For the next sample we will use an image object.
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 When connected, the object will assume the linked object value and every time it is updated also
the first object will also reflect the data from the linked object.

This option allows you to have two image objects, one at the front of the card and another at the
back of the card, sharing the same data.

4.4.11 - Alignment

 The alignment tab allows you to define the object alignment inside the boundaries.
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As you can see you can define vertically from top, middle or bottom and horizontally from left, middle
or right.

When the point size is in auto, on the font tab, it means that the font size justify the text to the
boundaries what makes the horizontal adjustment very small

 The default position is left and middle.
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4.4.12 - Script

 There are two different locations where you can write in cardPresso's  design area.  One for each
object and one for the document. In this chapter we focus on the object script.

This  is  an  advanced  user  area,  where  you  can  program  actions  and  procedures  in  javascript
language in order to define settings or update your object.

 This drop-menu allows you to define when the actions or procedures must take place.

 And in the space bellow you can write your lines of code.

 To see the log of your program output, change tab bellow.
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4.4.13 - Multi Align

 The multi  align tab is  only  displayed when three or more objects  are selected and is  divided  in
two classes, the alignment between objects and the distribution. 

 Alignment Between Objects - Aligns vertically  and horizontally  the  objects  to  top,  middle  or
bottom and to left, middle or right using as boundaries the card limits.

 Distribution  -  Allows  you  to  distribute  the  objects  on  the  card  area  equitably,  but  instead  of
using the card limits  as  a reference uses the object  boundaries  referring to the last  object  selected
that is marked with blue selection handles.

All other objects  will  be allocated according to the selection and having as  a reference the last  one
selected, notice that the reference object is  also the anchor and will  not  move,  all  the others  will  be
placed according with the distribution settings. 

In  short,  the  space  occupied  by  the  three  or  more  objects  will  always  be  the  same,  the  space
between them is the one that will be arranged. 
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4.5 - Edit View

 This chapter will explain you what the Edit View is about,  its  basic  concept,  features,  availability
and objective.

Imagine that you have a small business, with eight or ten employees and you want  to keep a record
for each and even print a card for time attendance or access allowance
And then you think… but I don’t now how to work with a database.

 Edit View is a very simple, small but powerful alternative to a  database,  where  you can
keep up to ten records, and manipulate them as you wish.

 The Edit  View is  available from our basic  edition,  the XXS, allowing you  to  have  a  first  contact
with cardPresso capability of database manipulation and if you don't  need more than ten records or
don’t know how to work with a database, then the Edit View may become your ideal solution.  

All the records are saved into you card document file, so there are no attached files or any other files
to look after and you can use an existing card template or create a new one.

Edit View  also allows editing any kind of field type that  you can find on any  other  database,  text,
date, numbers and also allows you to add and edit images of any kind.

Ok after the presentation we took a cardTemplate like the one on the picture below:

As you can see we have three workable objects, the name, the position and the photo.

 Click on the name, for example and then on the source tab on the Update option chose 'On Edit
View'
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 Then a new tab is available, the Edit View tab.

Very similar to the database tab, with the command buttons on the top and already with our name
field.
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 Go to the first record

 Go to the last record

 Go to the next record

 Go to the previous record

 Delete displayed record

 Add a new record

 To start  lets  give names to our objects,  like Name, Position and Photo,  it  will  be  easier  in  the
future to identify them.

To  add  the  other  objects  to  the  Edit  View the  process  is  the  same,  select  the  object,  go  to  the
source tab and on the Update option chose 'On Edit View'.

Now we have all three objects on the Edit View, to order them as you like just  drag and drop on the
tab.

All you have to do now is add more records, filling the fields on the 'Edit View' tab, up to a
maximum of 64 records (on XXS Edition only 10).



Chapter 5.
Database
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Chapter 5. Database

A  database  is  an  organized  collection  of  data.  A  database  is  typically  organized  to  model
relevant aspects of reality in a way that supports processes requiring this information

This  chapter explains  you how to connect  to a database through cardPresso and how to use  it  to
your advantage

5.1 - Connection

 In cardPresso there are two ways to connect to a Database.

One of them is by clicking on the Connect Database icon in the Dockbar.

The other is by selecting Connect in the Database Menu.
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5.1.1 - Configuration

 here are several Database Drivers at your disposal:

XXS  only  has the cards internal database accessible from the  Edit  View  as  explained  in  chapter
4.5

XS  has  the,  Direct  CSV  & TXT  File  Driver,  that  can  only  read  the  fields  in  these  databases.
Edition of their records isn't possible through cardPresso.
And the Direct Excel  File  Driver through which cardPresso can edit  the fields  and records of the
Database.
With these drivers it is also possible to add Links to images and their Folders.

XM  can connect  to SQLite  version 3 and the Direct MS Access File  Driver.  From  here  on  it  is
possible to Alter Tables and in the records add images as Binary file.

The cardPresso Internal Database (msAccess) becomes available in this Edition.

XL adds the ODBC Drivers and with them  it  is  possible  to  connect  to  any  Database  with  ODBC
Support, like: SQL Server; Oracle; MySQL; as others.

After selecting the Driver you will be prompted to Select or Browse to the Database.
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 The instructions on how to configure each Driver connection, will be addressed further on this
manual. 
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5.1.1.1 - Direct CSV & TXT Driver

 In the Direct CSV  & TXT  Driver  there  are  several  configuration  options,  usually  cardPresso
Guess function does the required configuration when the CSV or TXT file are opened.

 

 File Encoding - The File encoding is by default  as  'Auto',  if the encoding used by  the database
is on the dropdown list chose it.

 Type - Is for the Size of the Fields in the Database.

 Delimiter - It is possible to chose the Delimiter used in the Database or Input it.

 Field Type - Select the Field Type accordingly.

 Explanation on the next connection steps will be addressed further on this manual. 
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5.1.1.2 - Direct Excel Driver

 In the Direct Excel  Driver it  is  possible to confirm the structure of the database and if needed
add  more  Fields  to  it.  The  cardPresso  Guess  recognizes  the  structure  and  configures  the
connection, if the configuration isn't correct, change it accordingly.

 Worksheet - Chose the Worksheet to which the card is to be connected.

 Header - Select the Header of the Database.

 Data - Select from where the Rows start.

 Type - Select the Field Type accordingly.

 Explanation on the next connection steps will be addressed further on this manual. 
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5.1.1.3 - Direct MS Access Driver

 Since  the  data  stored  in  the  MS  Access  and  the  SQLite  Databases  has  a  fixed  format,  no
special configuration is needed. Just browse to the Database and open it.

The  cardPresso  Internal  Database  is  a  MS  Access  Database  provided  with  the  cardPresso
installer and serves as a Sample and for test purposes.

 

 Explanation on the next connection steps will be addressed further on this manual. 
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5.1.1.4 - Internal Database

Each cardPresso document contains an internal database as a smaller yet more convenient way
to keep records. This means you can have your own database records saved within the cardPresso
document itself, without need of external database files.

To connect to the  internal database you can use the Connect to Database button.

On the following window select document Internal Database.

 

You can then use Database Operations to create your own tables and columns and save them on
your cardPresso document.

5.1.1.5 - ODBC

 The  Open  Database  Connectivity  (ODBC)  provides  the  means  to  connect  to  several
Databases, such as, SQL Server, Oracle, IBM, Fox Pro, dBase and others.

In case of Databases containing special characters, the usage of the Open Database  Connectivity
(ODBC) ansi is advised.
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By selecting the ODBC Administrator these options are available:

User DSN - Shows the existing connections and provides the possibility  to Add more  connections
and Remove or Configure existing connections.

System  DSN  -  Shows  the  existing  connections  and  provides  the  possibility  to  Add  more
connections and Remove or Configure existing connections.

File DSN - Provides the means to connect to a data provider.

Drivers - Shows the connection Drivers installed on the system.

Tracing - Provides the means to log the calls to the ODBC drivers for use by the support personel or
to aid in debugging your applications.

Connection Pooling - Provides the means to reuse open connection handles.

About - Shows the ODBC core components available.

 Please contact your SysAdmin for the configurations required to connect with your Database.

 Explanation on the next connection steps will be addressed further on this manual. 
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5.1.1.6 - MySQL Driver

 The MySQL Driver allows to connect to a MySQL Database.

 

 Please contact your SysAdmin for the configurations required to connect with your Database.

 Explanation on the next connection steps will be addressed further on this manual. 
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5.1.2 - Database Operations

 The Database  Operation is  an important  function for XM and higher Editions.  In the Database
Operation  it  is  possible  to  Select,  Create,  Alter  or  Drop  Database  Tables,  making  it  possible  to
personalize a Database with cardPresso.

Since  the  CSV,  TXT and  Excel  Databases  do  not  have  multiple  Tables  only  the  Select  Table  is
possible in their case.

 

This example is based on the cardPresso Internal Database.
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5.1.3 - Table Columns

 In this part of the Database Connection Wizard it is possible to select which columns of the
selected Table you need.

 

 If no column is selected the Wizard won't continue.
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5.1.4 - Guide Columns

 The Guide Columns will work as an Index of the Database.
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5.1.5 - Database Filter

 In the Database Filter you can add conditions to filter what  is  shown from the database.  These
conditions have to be written in SQL Script without the "Select * where".
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5.1.6 - Order Columns

 With the Order Columns it is possible to change how the database is shown in cardPresso.

The organization rules used by cardPresso for the selected columns are: 

Empty  fields  first,  then  the  Numeric  fields  from  the  smallest  value  (0)  to  the  biggest  value  (±9),
followed by the fields in Alphabetic order.
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5.1.7 - Properties

 It is possible to review the configuration of the Database connection through the Database  Menu
and selecting Properties.

 

 The Database Properties are mainly used to check the configurations of the connection.  Do not
change them unless necessary.
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5.2 - Dockbar

 The buttons in the Dockbar ease browsing between records and managing the Database.

Database 

Connect

Disconnect 

Database

Database

Refresh

First Record Previous 

Record

Next

Record

Last

Record

Revert

Record

Changes

Insert

Record

Delete

Record

Save

Record

 

5.3 - Database

 As it is with cardPresso Document Objects the Database Fields  can also be added to the card
Layout through Drag&Drop. These Objects will be connected to the Database Field and update when
the field in the database is changed or when moving between records.
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5.4 - Find or Filter

 The Database Find Tab eases the search for specific records in the Database.

It is possible to search in the available variables  if the data in a column of the Database is  or has a
value, as input by the user to the Textbox.

 The Database Filter works as  an SQL Query  and in it  there are available the same options as
in the Database Find with the possibility to search with multiple rules and with a personalized Script.

The  Database  Filter  Tab  can  also  be  used  to  generate  the  Script  for  the  Database  Filter  in  the
Connection Wizard.
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When using the Contains filter, if you are searching with a partial word, you must use the % symbol
on the search term. 

Eg: Searching for a word that starts with "card": card%
      Searching for a word that ends with "Presso": %Presso
      Searching for a word that contains the text "ardPres": %ardpres%
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5.5 - Database View

Browsing and editing a database is made simple with the Database View.
Here you can see a list of all the database records and edit them with in a convenient interface,
made to simplify browsing and editing records.

To access the Database View, click the Database View button or open the cardPresso menu
View > Database View.

Note: The Database View will only show data when connected to a database.

 Browse Records - Opens the Browse Records tab which lists all the records in a reader friendly
way .

 Edit Records - Opens the Edit Records tab provides you with a more convenient  interface to edit
each database record.

5.5.1 - Browse Records

The Browse Records view is a tool that alows you to see all the records in your database in a
simple and reader friendly environment.

Here you can also individually select records for when you want to print several specific records in
the database (see more on Printing Selected Records in a Database).

You can access the Browse Records window trough the Database View button, then Browse
Records button, or trough the cardPresso menu View > Database View, then Browse Records
Button.
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 Hide/Show Photo Columns - Toggles between hiding or showing database columns which contain
images.  Ideal  for  larger  databases  with  a  large  amount  of  pictures,  which  can  be  very  memory
intensive. 
When disabled this option allows for higher performance in computers with slower resources.

 Select All - Selects all the records in the database.

 Select None - Deselects all the records in the database.

 Toggle  Selection  - Individually  toggles  the selection on all  database items  that  are  listed  (Does
not apply to items that are not visible trough Database Filter).

5.5.2 - Edit Records

The Browse Records view is another powerf tool in cardPresso which allows you to quickly edit
database records, making database management fast and simple.

On the left side of the Browse Records window you can find the columns which contain text.
ON the right side, you can find all the the Image items contained in the database.
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Simply browse the records with the top Database Toolbar until you find the database record you
want to edit, then edit the database record and click the Save Record button.

5.6 - Managing Records

Adding, deleting and editing records are core tasks when managing a database and when working
with large databases, it can become a time costly task.

With all the tools provided by cardPresso, managing databases becomes simple and intuitive.

5.6.1 - Adding Records

Adding records in cardPresso is quick and simple:

1 - Make sure you are connected to a database (see more on chapter 5.1 - Connection)

2 - Open the Database sidebar when working on the Card Design view (see more on chapter 5.3
Database). 

Alternatively open the Browse Records window on the Database View (see more on chapter 5.5.2
Edit Records).

3 -  Click the Insert Record button on either the Database Toolbar or trough the cardPresso menu
Database > Add Record.

4 - The Database Items will now be empty and ready to be written.
Finally, fill the items with the required data and click the Save Record button to save the changes.
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Prior to saving you can cancel any changes with the Revert Record Changes buton:

5.6.2 - Editing Records

Editing existing records is also a quick and simple task:

1 - Make sure you are connected to a database (see more on chapter 5.1 - Connection)

2 - Open the Database sidebar when working on the Card Design view (see more on chapter 5.3
Database). 

Alternatively open the Browse Records window on the Database View (see more on chapter 5.5.2
Edit Records).

4 - Use the database toolbar to find the record you wish to edit.

4 - Finally, fill the items with the required data and click the Save Record button to save the
changes.

Prior to saving you can cancel any changes with the Revert Record Changes buton:

5.6.3 - Deleting Records

Deleting existing records is also a quick and simple task:

1 - Make sure you are connected to a database (see more on chapter 5.1 - Connection)

2 - Open the Database sidebar when working on the Card Design view (see more on chapter 5.3
Database). 

Alternatively open the Browse Records window on the Database View (see more on chapter 5.5.2
Edit Records).

4 - Use the database toolbar to find the record you wish to delete.
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5 - Click the Delete Record button and when prompted if you want to delete the record, click the
Yes button.

Note: Deleting a record is a permanent action that cannot be reverted, canceled or undone.



Chapter 6.
Printing
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Chapter 6. Printing

 Printing  your  cards  is  the  core  function  of  cardPresso.  Within  this  chapter  we  describe  the
several  printing  configurations  cardPresso  provides  for  printing  and  how those  settings  work  with
your printer to achieve the best printing results.

To ensure that the finished card appears as intended you should understand basic  printing principles
such  as  the  resolution  of  your  printer  or  the  calibration  and  resolution  of  your  monitor.  These
specifications are provided by  the printer manufacturer and in the display  settings of your Operating
System.

Make sure you have the latest printer driver and firmware versions for the printer you have installed.

6.1 - Printing with cardPresso

  The computer you wish to  print  a  card  from  must  be  connected  either  to  a  local,  shared,  or
network printer and be configured to use that printer.

1. Make sure that you’ve installed the correct printer driver for your printer.

2.  Click the Print Button, or choose File > Print.

3. If  connected  to  a  database  (see  more  on  Chapter  5.  Database)  you  can  use  the  Database
Selection options to select  the  records  you  want  to  print  (see  more  on  Chapter  6.1.1  Printing
With a Database):

4. Update record after print writes  a user determined value in the selected database field of each
database record that is printed, after being printed.

5. Copies sets the number of copies to print for each print job / record.

6. Driver  Options  opens  the  Printer  Driver  properties  of  your  currently  selected  printer.  Set
additional printer driver options in your operating system. See your printer driver documentation for
details.

 
7. Print Operations  allows you to select the operations you wish to run on each print job.

Click OK to start the print job with your currently selected options.
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6.1.1 - Printing With a Database

 Print  jobs with large databases can be very  lengthy  and complicated.  That's  why   cardPresso
provides  you  with  several  options  you  can  use  to  your  advantage  to,  making  printing  with  large
databases a much simpler job.

6.1.1.1 - Printing a Database Range

 Print  Range  allows  you  to  choose  a  range  of  records  within  a  database  to  be  printed
automatically. This range can vary from one card to several cards.

1 - In the From field, select the starting point you want for your print job.

2 - In the Number of records, type the number subsequent records you want to print.

When selecting a range,  you have 3 options to select  which is  the record you want  to start  to print
from:

Start Record starts printing from the first database record.

Current Record starts printing from the database record that's currently open.

Last Record starts printing from the last database record.

After  selecting  which  record  to  start  from,  Number  of  records  let's  you  choose  how  many
subsequent records you want to print besides the starting record 

Eg: If selected From: Start Record, Number of records: 100 cardPresso would print  all  database
records ranging from 1 to 100.
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6.1.1.2 - Printing Selected Records in a Database

 Selected  Records in  browse  view  lets  you  select  which  records  to  print,  one  by  one,  by
selecting them previously in the Browse Records window in  Database View.

1 -  Click the Database View button, or choose View > Database View

2 - Select the records you want to print on the Browse Records window, using the checkboxes.

3 -  Click the Print button, or choose File > Print.

4 - Select the Selected Records in browse view option and click OK to print.

 In the image above the records to be printed are 3; 5 and 8.
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6.1.1.3 - Printing with Conditional Printing from a Database

 Conditional Print lets you configure a print rule using a value from the database records.  When
printing, cardPresso will search trough all records within the database and will only  print  the records
that comply to the rule you have configured.

1 - Select the database Column which contains the data to be validated.

2 - Select the condition that fits the print rule you want.

3 - Click OK to print only the database records that follow your print rule.

 This option is only available in cardPresso's XL Edition or higher.
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6.1.1.4 - Update after Print

 Update  Record after Print  allows  you  to  change  a  record  to  save  relevant  print  information,
after being print.

By using  your  own  text  or  one  of  the  options  available  in  cardPresso  it  is  easier  to  mark  in  the
database the records that have been printed, the amount of cards printed for that specific record and/
or the print date of the last card.

1 - Select the Column wich you wish to update.

2 - Type the data you want to store, or choose one of the available options cardPresso provides.

 

6.1.2 - Copies

 Number of copies lets you set the number of times each card will be printed.
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6.1.3 - Print Operations

 In  the  Print  Operations   you  can  find  the  print  and  encode  tasks  that  occur  in  each  print,
depending on the Card Type in use.

As  an  example,  a  CR-80  Card  Type  layout  would  only  show  the  Print  Front  and  Print  Back
operations.

 The operations selected in this area are the only ones sent for printing.
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6.2 - Print Settings

 Printer Settings allows you to configure the basic  layout  settings of your card,  configure Print
Options which adapt  to your to your printing needs,  and gives you access to  your  printer's  Driver
Options.

 To configure your Printer Settings, click File  Configure print or Ctrl+Shift+P.

 Paper Size, selects the paper size supported by the chosen printer.

 Orientation, selects the orientation of your document. Landscape or Portrait.

 Print  Options,  shows  you  the  current  Driver  Properties,  select  the  Rendering,  Advanced
options and the Overlay.

  Driver Options, opens the configurations of the currently selected Printer. 
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6.2.1 - Printer

 In this area you can choose which Printer you want  to use,  its  Paper Size  whether it  is  Letter
as  used  by  A4  printers,  CR-79,  80,  90  or  any  size  recognized  by  the  card  printer  and  the  card
Orientation.

 To  view the  Printers  installed  on  your  computer  and  their  Driver  version  click  cP   Printer
Drivers.
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6.2.2 - Print Layout

 The Print Layout settings change depending on the Card Model  you choose.  In its  drop-down
list you can choose the Card Types available in your cardPresso Edition.

+

Different Card Models have different Print Layout settings.

In the case of paper printers the you can print  multiple cards in one page.  cardPresso provides you
with a simple grid system that you can modify to fit your printing needs. 

Print  Layout  lets  you  choose  the  number  of  rows,  number  of  columns,  top  margin,  left  margin,
vertical and horizontal spacing. As you can see in the image below. 

 Card Model, selects your card type.

 Orientation, selects the orientation of your card in document.

 Columns, number of columns.

 Rows, number of rows.
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 Top Margin, left margin of your document.

 Left Margin, top margin of your document.

 Vertical Spacing, vertical spacing between cards.

 Horizontal Spacing, horizontal spacing between cards.
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6.2.3 - Options

 The Print Options section contains information and configuration settings on how the print job is
sent to the printer Driver.

The Driver section shows the basic driver info of the printer currently selected.

The  Rendering  settings  allows  you  to  configure  advanced  Black  rendering  options,
Antialiasing, and Composite Black Replacemet.
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Black,  configures  how the  black  color  is  sent  to  the  printer.  You  can  Send  as  RGB;  Send  as
Monochrome;  Send  as  RGB  and  Monochrome;  Send  Composite;  Send  Composite  and
Monochrome or send as a Separate Render (default option).

Antialiasing, lets you enable or disable Antialiasing for either the whole card,  for Text only  and for
Images only.By default, the option is active.

Composite  black  replacement,  You  can  use  composite  black  replacement  with  one  of  the
following options:  Using the options available:  Grayscale  (Low,  Medium  or  High),  Color  Decrement
(Low, Medium or High) Red Increment (Low, Medium or High).

Black,  To  obtain  the  desired  results,  you  can  submit  the  black  in  RGB;  monochrome;  RGB  and
monochrome; composite; composite and monochrome and separate render;

Composite black replacement, You can activate composite black  replacement,  using the options
available: Grayscale (Low, Medium or High), Color Decrement (Low, Medium or High) Red Increment
(Low, Medium or High).

The Advanced section provides you with the following options.
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Rotate 180, Rotates the layout by 180º when sending the print job.

Flip Horizontal, Flips the layout horizontally when sending the print job.

Flip Vertical, Flips the layout vertically when sending the print job.

Use Colored Card, Sends the print job optimized for when your card is than white. 
You can select from Black, Green and Yellow.

Print  Jobs,  By  default  the  print  job  is  sent  as  "All  Print  operations",  in  this  case  cardPresso
sends all print jobs whether each print job was successful or not.

With Card by Card cardPresso only  sends the next  card to be printed,  after  receiving  a  success
signal from the printer.

With Card by Card and  Wait  cardPresso  sends  the  print  job  one  by  one,  and  waits  for  a  user
input. cardPresso will  wait  for a user confirmation that  each selected print  job is  successful before
sending the next print job.

Overlay/Varnish:

Mode: By default the Overlay is Disabled. Depending on the Printer in use it is possible to send the
Overlay Layout during the print job to the driver by saving it to an External file or directly to the
printer as Separate Page.



cardPresso Manual166

© 2014 cardPresso, Lda



Chapter 7.
Encoding



cardPresso Manual168

© 2014 cardPresso, Lda

Chapter 7. Encoding

 cardPresso's other core function is  encoding.  The  process  of  encoding  consists  in  converting
information from one format to another, and in the context  of cardPresso,  storing that  information in
a card.

To that end cardPresso provides you with a dedicated workspace stocked with tools  focused solely
on Encoding and managing the way information is sent to your card.

This workspace is called Encode View.

7.1 - Encode View

 The  Encode  View  is  where  you  view manage  the  encoded  information  in  your  card  and  the
encoding operations to be performed when encoding to your cards.

You can access it by clicking the Encode View button, or trough the menu View > Encode View.

This section gives you access to the various sections that manage the encoding process.

The Encode Model window shows a visual representation of the way data is stored in each card.

The Data Inspector window shows the data currently being browsed in the Encode Data window.

The Encode Script window shows the encode commands that run when the card is encoded.

The Properties window,  to  the  right,  has  its  own  set  of  options  in  the  Properties section  which
provide you with convenient information and tools to make Encoding fast and easy.

7.2 - Encode Model

 The  Encode  Data  window is  a  visual  representation  of  the  way  information  is  stored  in  your
card. It allows you to easily browse the card for a quick access to the information stored.
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You can find it by clicking the Encode View button.

Different Card Types have different types of Encode Data organization.

Here is an example of the Encode Data window of a Mifare card:

7.3 - Data Inspector

 The Data Inspector window shows you the data currently  stored on the item you select  on the
Encode  Data  window  and  allows  you  to  manipulate  the  stored  data.  This  gives  you  a  quick
reference  of  the  data  stored  in  your  card  and  eases  the  workflow while  working  on  your  Encode
Operations.

You can find the Data Inspector window by  clicking the Encode  View  button,  or clicking View
> Encode View.

The information shown on Data Inspector also changes depending on the Card Type.

The Data Inspector window organizes the information stored in your card in 3 columns:

Block shows the card block currently selected in the Encode Data window.

Hexadecimal shows the hexadecimal value of the data currently stored on the selected card block.
If the user has changed the value using the Edit button,  it  will  show the  new value  entered  by  the
user)
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ASCII shows the value of the Hexadecimal field in regular text format.

Here is an example of the Data Inspector window of a Mifare card where we wrote the hexadecimal
value for the word "cardPresso":

 The Data Inspector window comes with a set of tools that  allow you to quickly  view and modify
the data stored in your card:

The Edit button allows you to directly modify  the information stored in the item currently  selected in
the Encode Data window. The Edit button works with Hexadecimal values.

The information will only be written in the card when you press the Write button.

The Read button allows you to read the information stored in the item currently selected in the
Encode Data window.

The Write button writes in the card the value currently visible in the Hexadecimal separator of the
item currently selected in the Encode Data window.

The Continuous Read button makes cardPresso repeatedly read the data in the currently  selected
item every two seconds.
This  allows  you  to  perform  several  write  functions  in  the  Encode  Operations  window  and
immediately see the results on the Data Inspector window.
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7.4 - Encode Script

 The  Encode  Script  window  is  where  all  the  code  that  manipulates  how  the  information
pertaining your cards is  written into the cards.  You can program  and  test  all  the  encoding  actions
you want before printing trough this window.

You can find the Encode Script window by  clicking the Encode  View  button,  or clicking View
> Encode View.

The actions written here will then occur each time the card is encoded.

Here is an example of the Encode Operations window of a Mifare card type:

 By default the Encode Operations window comes with some commented basic sample code to
get you started on the most common Encode Operations of the selected card type.

If a line is  commented the code it  contains  will  not  run  under  any  circumstance.  To  run  you  must
remove the comment tag ( // ) in the beginning of the line).

In the previous example the line containing the code "mifare.write(5,2"cardPresso");"  is  the  only
one that will run because it's the only code line that is not commented.

The various Encode Operations also change with each Card Type.
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7.5 - Properties

 The  Encode  View  also  has  it's  own  set  of  Properties tabs  located  as  usual  to  the  right.  It
provides  you  with  several  separators  which  contain  convenient  information  about  your  card,  your
printer,  your  users,  your  database  and  scripts.  All  with  more  tools  to  make  your  Encoding
Operations even smoother and easier to implement.

 You  can  find  the  Encode  View  Properties  tab  by   clicking  the  Encode  View  button,  or
clicking View > Encode View.
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7.5.1 - Preview

 The Preview tab provides you with a quick overlook on the card design.  You can swap between
the  front  and  the  back  of  the  card  design  preview by  clicking  the  Front  button  and  Back  button
respectively.

You can find the Preview tab by  clicking the Encode View button, or clicking View  > Encode
View and clicking the Prevew tab on the right .

7.5.2 - Printer Tools

 Printer Tools are a powerful set  of tools  that  allow you to  manually  navigate  your  card  inside
your printer (in printers that support these functions) so you have more control over how your printer
uses  your card while writing your Encode Operations.

The available printer tools vary with the printer modules installed on your printer.

You can find the Printer Tools tab by  clicking the Encode View button, or  clicking View  >
Encode View and clicking the Printer Tools tab on the right .

Insert card from card input  feeder  inserts  a  card  positioned  in  the  printer  input  feeder  into  the
printer circuit.  

Insert card manually allows you to manually insert the card directly in the position you desire.

Position card at contact encoding unit  moves  the  card  from  its  current  position  to  the  contact
encoding unit.

Position  card  at  contactless  encoding  unit  moves  the  card  from  its  current  position  to  the
contactless encoding unit.

Move card out of contactless encoding unit moves the card out of the contactless encoding unit.

Eject card to dispenser unit moves the card from it's current position to the card dispenser unit.
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Eject card to reject unit moves the card from it's current position to the card dispenser unit.

Magnetic Encoder allows you to read the content the 3 tracks of a magnetic card.

Direct Commands allows you to send commands directly  to the printers  who  support  this  feature
(please refer to the printer manufacturer for a list of supported commands).

 These options work only with printers that support commands.

7.5.3 - Database

 The Database separator works Encode View exactly the same way as  in the other views.  You
can browse your records,  edit  them  and  drag  them  into  the  Encode  Operations window.  Making
your work with Encode Operations in cardPresso even easier and faster!

You can find the Database  tab by   clicking the Encode  View  button,  or   clicking  View  >
Encode View and clicking the Database tab on the right.



cardPresso Manual176

© 2014 cardPresso, Lda

 



Chapter 7. Encoding 177

© 2014 cardPresso, Lda

7.5.4 - Database Filter

Database  Filter is  yet  another strong tool that  makes the work-flow on  Encoding  Operations
much smoother and faster in cardPresso.

You can apply  Database  Filters on cardPresso so you only  see the  records  with  the  information
that matters the most to you. Making browsing database records a much easier and cleaner task.

You  can  find  the  Database  Filter  tab  by  clicking  the  Encode  View  button,  or  clicking  View  >
Encode View and clicking the Database Filter tab on the right .

To do so, simply select the column which contains the data you want to filter. 

Select the condition to filter which matches your needs.

Insert the value you want to filter

Select Add Condition and click Apply (You can add more filters by selecting And or Or).

Now when  you  browse  your  database  records  on  the  Database  tab,  only  those  that  follow  the
condition will show.
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7.5.5 - Database Find

 Database  Find  is  a  quick  reference  tool  that  lets  you  find  specific  values  throughout  your
database.

You  can  find  the  Database  Find  tab  by  clicking  the  Encode  View  button,  or  clicking  View  >
Encode View and clicking the Database Find tab on the right .

Select the Column in which you want to find a value.

Select the condition that fits your situation.

Insert the value you want to search for.

Use the buttons to navigate trough the records which comply with the condition.
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7.5.6 - Script

 The Script separator is the Document script and if you previously  added code,  it  will  be located
here. See more on Chapter 4.4.12 - Script.
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Chapter 8. Users

 When working with multiple collaborators,  managing  and  providing  select  permissions  to  each
individual becomes crucial.

Users is  yet  another powerful management  tool  provided  with  cardPresso  to  help  you  specifically
with user management, allowing you to limit who can access cardPresso and what they can do. 

Users provides you with tools that allow you to create and manage user logins  for cardPresso.  This
gives you full  control over who has access to  cardPresso  and  what  they  can  do.  With  the  added
ability to create groups, managing large numbers of users becomes as simple as a single click.

8.1 - Users View

 The Users View  gives you access to all  the tools  that  allow you browse,  add,  remove and edit
Users and Groups.  It  also gives you access to an overview of all  their operations and an additional
option to print customized audits.

You can access the Users View by clicking Window > Users View:

The Users View is separated in 5 smaller sections:

The Users View Toolbar provides you with the basic tools to add and remove users, add and
remove groups and print audit reports:

Audit Report Prints an Audit Report for different files formats.

Add User Creates a new user.

Remove User Removes the user currently selected in the Users section.

Add Group Creates a new group.

Remove Group Removes the user currently selected in the Users section.

Refresh Views Reloads the users database on the Users View.

 The Users section located in the top left  of the Users Vew  shows a list  with all  the users  you
currently have configured in cardPresso. 
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 The  Groups  section  shows  you  a  list  with  all  the  groups  you  currently  have  configured  in
cardPresso and it's respective users.

The Auditing section is  located in the bottom half of the Users View  and it  shows a list  of all  the
actions performed by each user.

 You must  first  enable auditing for the intended users  in the User Properties tab by  editing the
user (see more on: Chapter 8.2.5 Edit a User).

The Properties tab is  located as  always to the right  of the Users View.  It's  contents  also  change
depending on what you are currently doing, whether it's adding new users  and groups or editing their
respective settings, all the information is shown and edited here.
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Above is the properties tab while a user is selected.

8.2 - Users

 A User system is a combination of a user name and a password and,  if enabled,  are required to
access cardPresso. The user name and password identify  each person that  accesses cardPresso
 and determines what they can or can not do within cardPresso by attributing each user with its own
set of permissions.

8.2.1 - Enabling User Logins

 The first step to work with users is enabling user logins. You can do this by accessing the Users
View   by  clicking the cardPresso menu Window  > Users View  and in the  bottom  of  the  window
clicking the Enable user logins checkbox.

The  first  time  you  enable  user  logins,  you  will  be  prompted  with  the  default  user  name  and
password. 

The default user name is ADMIN and the default password is admin:

This information will only appear once.
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8.2.2 - Login

 After enabling users  logins,  when you open cardPresso you will  be required to  enter  the  login
credentials on the welcome screen. 

Simply type the credentials and  click the OK button.

Every user that is created can login in this fashion.

8.2.3 - Add User

 With user logins enabled the next  step to managing your users  is  adding them. You do this  by
clicking the Add User button found in the Users View Toolbar.

Doing  so  will  open  the  new user  options  in  the  properties  tab  where  you  will  be  prompted  to  fill
various fields required to create a new user:
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Login: Write the username the user must insert when logging in cardPresso.

Name: Write the name of the owner of this username.

Password: Write the password the user must insert when logging in cardPresso.

Confirm Password: repeat the password to validate it.

Diable  user  (cannot  login):  The  user  won't  be  able  to  log  in  cardPresso  until  this  option  is
disabled (unchecked).

Enable auditing: Every user action within cardPresso will  be recorded and visible in the Auditing
section.

 Click Save to save the new user. It will then be available for editing in the Users section.

A new user will have no permissions until  assigned to a Group (see more on Chapter 8.3.2 Add
Group).

8.2.4 - Remove User

 To keep a clean and up to date user base you can remove Users that  are no longer needed by
selecting the user  you  want  to  remove  and  clicking  the  Remove  User  button  found  in  the  Users
View Toolbar.

If  a  user  is  removed  its  user  name  and  password  will  no  longer  work  when  logging  in  losing  all
access to cardPresso.
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 Removing a user is a permanent action that cannot be undone.

8.2.5 - Edit a User

 cardPresso
To edit an existing User select the user you want to edit in the Users section on the Edit Vew:

 

Once selected, the user's data will be editable in the properties window to the right:

When done editing, to save the changes  click the Save button.

 Once created, the user Login field cannot be edited.
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8.3 - Groups

 cardPresso  adds  Groups to  its  User  management  system  to  ease  editing  large  numbers  of
users.

Here you can add Groups and select each group's specific permissions and assign them to multiple
users.

When a User is assigned to a Group, it inherits all  the permissions the Group currently  has.  Every
change to the group's permissions affects the permissions of all the users assigned to it.

 A user with no group assigned will have no permissions.

8.3.1 - Add Group

 To add a Group  click the Add Group button found in the Users View Toolbar.
 
Doing so will open the new group options in the properties tab where you will be prompted to fill
various fields required to create a new group:
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Group*: Write the unique name cardPresso will use to identify the group.

Name: Write the name of the Group for easier identification.

Location: Write the name of the location/department/category of the users assigned to this group.

Users: Select the Users that belong to this group.

One user can belong to more than one group.

Permissions: Select the permissions that the users assigned this group will have.

 Click the Save button to save the group with the selected settings.

*required field
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8.3.2 - Remove Group

 If a group is no longer needed you can remove it by selecting the Group you want to remove and
clicking the Remove Group button found in the Users View Toolbar.

If a group is removed all users assigned to it will lose all permissions the Group had.
 

 Removing a group is a permanent action that cannot be undone.

8.3.3 - Edit a Group

 To edit  an existing Group select  the group you want  to edit  in the Group  section  on  the  Edit
Vew:

 

Once  selected,  the  groups  data  and  permissions  will  be  editable  in  the  properties  window to  the
right:
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When done editing, to save the changes click the Save button.

Once created, the user Group field cannot be edited.

8.4 - Auditing

 The Auditing section in Users View  is  where you can see every  action performed by any user
in cardPresso.

To audit a user you must first Enable Auditing for the intended user in the User Properties tab by
editing the user (see more on: Chapter 8.2.5 Edit a User).

After enabling auditing for a user every  future action that  user performs in cardPresso is  registered
and listed in the Auditing section
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8.4.1 - Audit Report

 For an easier view purposes cardPresso allows  you  to  print  or  export  customizable  Auditing
Reports.
You can do this by clicking the Audit Report button on the Users View Toolbar.

Doing so will  open  the  Audit  Report  editor  window,  where  you  can  customize  your  reports  before
printing or exporting them to files.
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Appendix A - XXL Net License

 The cardPresso XXL Edition includes the Net License Service. This service allows you to use
the same license in 16 different computers connected to the same Local Area Network (LAN).

To use this  service,  one  computer  must  have  the  cardPresso  XXL  Edition  USB dongle  and  be
connected to the same LAN as the other computers.  When the Net  License service is  activated on
this computer, it acts as Server and provides the license to a total of 15 computers  connected to the
same LAN.

The  cardPresso Net License  Service  only works on a  LAN.  It  does not  work  trough  the
internet.

 For best results, the computer with the Net License  Service  should have a Static  IP Address.
The computer acting as  the Net  License  "Server"  does  not  need  to  have  a  Server  type  Operating
System.

To ensure the Net  License  Service  is  always  available  to  the  other  computers,  the  USB  dongle
should be connected to a computer that  computer that  is  either always turned on,  or at  least  when
the other computers require the Net License Service.

Appendix A.1 - Installing the XXL Net License Service

 To install cardPresso's Net License service please do the following:

 1 - Install cardPresso on the computers but without the service.
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2 - In the computer that will run the service and act as the server, open the cardPresso menu
cP>cardPresso License

3 -In the cardPresso License window, click the Net tab click on the  Run as Application button:
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 On systems using Windows Firewall, a warning will pop-up, please allow the cardPresso
connection trough the Local Area Network.

Some Firewall applications will not show any warnings and automatically block the License
Service, the required permissions are at the end of these instructions.

This will open a command line window which will show you if the ports are open and if a cardPresso
application is running in the network.
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In this example
192.168.2.138 is the Host computer acting as a Net License server, providing the license.
192.168.2.136 is the Client computer receiving the license.

4 - Close the cardPressoLS.exe window and click Install as Service

5 - Run the service and confirm it's running.
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6 - In the License Service Client Computer use the default configurations or change it based on your
networks characteristics.

Now you can have up to 16 computers in your Local Area Network, including the one acting as a
server, running cardPresso XXL edition.

 If cardPresso doesn't automatically detect the license in a Client computer, open a command
prompt window (Start Menu > Run> cmd.exe) type "ping CARDPRESSO_LS" and hit return. 

If the host isn't found as shown above, please confirm that it is in the same Local Area Network, and
if so, open a port in the firewall for:
CPSECURITY_SERVICENAME "CARDPRESSO_LS"
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CPSECURITY_SERVICEPORT 1947
(TCP to communicate and UDP for the name)

If the ping requests an answer from an IP address that doesn't belong to the Local Area Network and
has no answer, retest the ping after rebooting the Router and/or use a different router.

 Warning : If the License Service is added (Step 3) to multiple computers, a License Service
"cluster" is created and it will drown the real License Server.

Also, the Net License uses WINS or NetBios to assign the License to the client computers.
Therefore the License won't be assigned to a cardPresso application outside the WINS or NetBios
range.



Appendix B -
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Appendix B - Advanced Print Operations

 cardPresso  contains  several  advanced  features  to  provide  you  with  the  flexibility  required  to
adapt to any circumstance.

In this chapter we will show you an overview on which features are available, how they work,  and how
to best use them to make your printing jobs simple,  fast  and most  importantly,  exactly  the way you
want them.

Appendix B.1 - Overlay

 By default cardPresso uses the printer's default overlay pattern. However cardPresso also gives
you other options regarding how you work with the Overlay ("O" Ribbon).

You can access the Overlay options trough the cardPresso menu File>Print Settings, 

cardPresso gives you three options:

1 - Separate Page lets you design your own Overlay with cardPresso's Design Vew.

2 - External File lets you design an Overlay within cardPresso so later when printing it can be used
trough your printer's driver settings.

3 - Use the printer's default default overlay pattern by disabling cardPresso's overlay customization.

Important  notes  regarding  how  printers  work  with
Overlay:

 Printers  which support  overlay  printing have their own overlay  settings.  These  settings  override
cardPresso's.settings.  This  means the printer's  settings  determine  if  the  overlay  is  printed  or  not,
regardless of cardPresso's configuration.
 You  can  your  printer  settings  find  them  on  your  Printer  Options  trough  the  cardPresso  menu
File>Print Settings, Driver Options button.

 cardPresso  can  only  print  overlay  if  the  printer  being  used  supports  overlay  ribbons,  has  an
overlay ribbon installed and has the overlay option enabled in it's own Driver Options.

 If  the  overlay  option  is  Disabled  in  cardPresso  but  the  printer  Driver  Options  have  overlay
enabled, the printer will still print overlay.

 If  an  overlay  option  is  enabled  in  cardPresso  but  the  printer  Driver  Options  have  overlay
disabled, the printer will not print overlay.

 To prevent unintentional Overlay printing, we recommend disabling the Overlay  printing option on
your printer driver settings while designing your Overlay.  Enabling  it  only  it  when  you  are  ready  to
print.

Appendix B.1.1 - Separate Page Overlay

 One of the ways cardPresso allows you to customize your own Overlay  is  by  providing you with
a separate page within cardPresso where you can design your Overlay  the  same  way  you  design



cardPresso Manual202

© 2014 cardPresso, Lda

your cards. 

This  option  is  found  trough  the  cardPresso  menu  File>Print  Settings,  Print  Options>Overlay/
Varnish>Mode>Separate Page.

When this option is selected, below it, you will have access to another setting:

Side: Lets  you  choose  the  side  of  the  card  where  the  Overlay  is  to  be  printed.  You  can  choose
either Front or Back.

 

Once Separate  Page  is  enabled,  cardPresso will  display  an  Overlay/Varnish  tab  in  the  bottom
left corner of the Design View as shown highlighted in the image below:
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When you click  this  tab you will  have all  the design tools  cardPresso provides to design your own
Overlay.

 The Overlay/Varnish page can only be printed w ith the Overlay Ribbon.

Appendix B.1.2 - External File Overlay

 External file lets you design an Overlay within cardPresso and then export it as  an image file so
you can open it  trough your printer's  driver configuration.  This  way your  printer  will  print  all  images
with the selected image as the Overlay design.

This  option  is  found  trough  the  cardPresso  menu  File>Print  Settings,  Print  Options>Overlay/
Varnish>Mode>External File.

When this option is selected, below it, you will have access to more settings:

File:  Lets  you save your Overlay/Varnish design to a  .bmp  file,  to  later  be  used  by  your  printer
driver when printing.

Side:  Lets  you  choose  the  side  of  the  card  where  the  Overlay  is  to  be  printed.  You  can  choose
either Front or Back.
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Once External File is  enabled,  cardPresso will  display  an Overlay/Varnish tab in the bottom left
corner of the Design View as shown highlighted in the image below.

You can then open the Overlay/Varnish tab and use cardPresso's design tools to design your own
Overlay.
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After you finish designing your Overlay  in the Overlay/Varnish tab,  you can use the Overlay File
button in the Print Options shown above to save your design to a .bmp file.

Once the file is saved, you can use the Overlay settings on your Printer Driver settings to open the 

Appendix B.1.3 - Printer Default Overlay

 By  default  the  printers  which  support  Overlay  have  their  own  Overlay  design.  The  third  (and
default) Overlay Mode option is Disabled. When this  option is  selected cardPresso lets  the printer
use it's default Overlay design.

This  option  is  found  trough  the  cardPresso  menu  File>Print  Settings,  Print  Options>Overlay/
Varnish>Mode>Disabled.

When  this  option  is  selected,  no  more  options  are  available  and  cardPresso  will  not  send  any
overlay designs to the printer.
When printing, the printer will either not  print  overlay  if the option is  disabled on the printer settings,
or it will print overlay using it's default design enabled on the printer settings.

Appendix B.1.4 - IDP SMART 50 Overlay Settings

 The way the IDP Smart 50 printer works with Overlay requires the following configuration:
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The RGB value of objects in a “user defined mask” is the factor that SMART uses to distinguish
which panel is used.
R value is for the Overlay (O) panel
G value is for  the printing (YMCK) panel
B value is for Fluorescent (F) panel.

Value “0” means ‘activated’ and value “255” means 'deactivated'.

 Examples:
- Blue = RGB(0, 0, 255) : printing and Overlay
- Pink = RGB (255, 0, 255) : printing only
- Black = RGB(0, 0, 0) : printing, Overlay and UV printing
- Red = RGB (255, 0, 0) : printing and UV printing

Appendix B.2 - Web Print Server

 The Web Print Server alllows you to remotely  print  cards  from  a  computer  that  doesn't  have
cardPresso installed. 
 
To use the WebPrint Server you are required to:

1 - Have a computer with cardPresso XXL Edition connected to a working local area network  (LAN
or Internet) to act as the Web Print Server.

2 - Have another computer (Client Computer) connected and to the same local area network  (LAN or
Internet).

3 - Use an external application on the Client Computer to send the Print Job trough IP to the server.
The Print Job format  must  comply  to the standard we provide in our website,  available for download
here. .

To use  this  service,  the  Web  Print  Server  computer  w ith  the  cardPresso  XXL  Edition  USB dongle

must  be  accessible  to  the  Client  Computer  via  IP  connection  either  trough  a  LAN  or  an  Internet

connection.

https://www.cardpresso.com/index.php/downloads
https://www.cardpresso.com/index.php/downloads
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Appendix B.2.1 - Configuring a Web Print Server

 The  first  setp  to  use  the  Web  Print  Server  service  is  configuring  the  computer  that  will  be
running cardPresso and receiving the print jobs.

To configure the Web Print Server you must:

1 - Save the card file you wish to print remotely on the My Cards folder:

1 - Create a copy or use an existing cardPresso windows shortcut, right click it and select
Properties.

 2 - Add the /PRINTSERVER switch to the shortcut Target after the quotation mark and click OK:
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3 - Open cardPresso as a Web Print Server with the new shortcut.

4 - On the Web Print Server window you must configure:
The IP Address of the computer acting as the Web Print Server.
The Port cardPresso should use to receive print jobs.
The User Groups (see more on Chapter 8.3) that can access the Web Print Server.

When all the settings are configured, press the Save button to save the changes and press the
green Start Service button, on the bottom right to start the Web Print Server.

If correctly configured, the button will turn red and the Status box will display a listen OK message
as shown below:



Appendix B - Advanced Print Operations 209

© 2014 cardPresso, Lda

Your Web Print Server is now running and has a .card file ready to be printed.

When working within a LAN (Local Area Network)  the  WebPrint  Server  computer  must  be  connected

to the same network as the Client computer that w ill send the remote print jobs.

When  working  trough  an  internet  connection,  both  the  WebPrint  Server  computer  and  the  Client

computer must be accessible to eachother trough a TCP/IP connection.

Appendix B.2.2 - Sending a Web Print Job to the Web Print Server

 With the Web Print Server configured and ready to recieve print jobs the last step to print  using
this service is sendind a Print Job to the server.

cardPresso has a preset format for the Print Job that should be sent to the server. You can find a
sample executable file on our website available for download here. 

 This sample file exemplifies how to remotely send the Print  Job data to the Web Print Server and
cardPresso reads the Print Job data.

The Item IDs sent from the Web Print Job must match the IDs of the items on the card that  is  to be
printed.

In the sample file the NAME item is declared as follows:

<item>
    <ID>NAME</ID>
    <VALUE>RUI FARIA</VALUE>
</item>

https://www.cardpresso.com/index.php/downloads/finish/20-cardpresso-manual-help/73-web-print-server-test
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Where NAME is the ID of the item to receive the value and RUI FARIA is  the data to be written and
printed.

When  sending  Images  to  the  Web  Print  Server  they  should  follow the  Base64  encode  scheme
(read more here).

Appendix B.2.3 - Web Print Job Sample

 Here is  a sample of a completely  formatted Web  Print  Job  data  to  be  sent  to  the  Web  Print
Server:

<cardPresso>
  <login>
    <name>ADMIN</name>
    <password>admin</password>
  </login>
  <cardDocument>
    <filename>example.card</filename>
    <data>
      <item>
        <ID>NAME</ID>
        <VALUE>RUI FARIA</VALUE>
      </item>
      <item>
        <ID>ADDRESS</ID>
        <VALUE>FUNCHAL</VALUE>
      </item>
      <item>
        <ID>PHOTO</ID>
        <IMAGE>/9j/4AAQSkZJRgABAQEAYABgAAD/2wBDAAIBAQIBAQICAgICAgICAwUDAwMDA
wYEBAMFBwYHBwcGBwcICQsJCAgKCAcHCg0KCgsMDAwMBwkODw0MDgsMDAz/2wBDAQICA
gMDAwYDAwYMCAcIDAwMDAwMDAwMDAwMDAwMDAwMDAwMDAwMDAwMDAwMDAwMDAw
MDAwMDAwMDAwMDAwMDAz/
wAARCAEAATQDASIAAhEBAxEB/8QAHwAAAQUBAQEBAQEAAAAAAAAAAAECAwQFBgcICQo
L/8QAtRAAAgEDAwIEAwUFBAQAAAF9AQIDAAQRBRIhMUEGE1FhByJxFDKBkaEII0KxwRVS0fAk
M2JyggkKFhcYGRolJicoKSo0NTY3ODk6Q0RFRkdISUpTVFVWV1hZWmNkZWZnaGlqc3R1dnd4eX
qDhIWGh4iJipKTlJWWl5iZmqKjpKWmp6ipqrKztLW2t7i5usLDxMXGx8jJytLT1NXW19jZ2uHi4
+Tl5ufo6erx8vP09fb3
+Pn6/8QAHwEAAwEBAQEBAQEBAQAAAAAAAAECAwQFBgcICQoL/8QAtREAAgECBAQDBAcF
BAQAAQJ3AAECAxEEBSExBhJBUQdhcRMiMoEIFEKRobHBCSMzUvAVYnLRChYkNOEl8RcYGR
omJygpKjU2Nzg5OkNERUZHSElKU1RVVldYWVpjZGVmZ2hpanN0dXZ3eHl6goOEhYaHiImKkpOUlZ
aXmJmaoqOkpaanqKmqsrO0tba3uLm6wsPExcbHyMnK0tPU1dbX2Nna4uPk5ebn6Onq8vP09fb3
+Pn6/9oADAMBAAIRAxEAPwD9CJvAd9F/y6y/9+6j/wCEVnh/1kEv/fuvbPNf1o+2SVr+8Nfanh/9gXH/
ADwk/wC/dR/2Of7kv/fuvePO838KDCk38Ef/AH7o/wC4Ye1PB/7N/wCelH9j9kr3j7Fa/wDPvHUc2j2M3
+stbaX/ALZ0f9ww9qeF/wBj0f2PXuA8H6VN1sY6jPgPQ5v+XGP/AL+UjX2h4n/Y9H9me9e2/wDCttH/
AOfeov8AhWOjzfwSmgPaHi/9j0f2PXtE/wAK9K8r/lrHUf8Awp+ym+5PL/37p/uzT2p43/Y9H9j17D/
wpm1m+5f5/wC2dRTfBP8AuXcdHtaYe1PI/wCx6P7Hr1j/AIUnP/BPbf8AkSo/+FJ33/PS2lo/
dknlf9j0f2PXqH/CmtS/uRVXm+D+qw/8uvm0fuzoPM/7Co/sd/WvRJvhjqUXWxqv/
wAIFfQj95Y3NWY+1OH/ALJ/2KP7C/2K7SbwfPD/AMsZf+/dRjw3JB/B0/6Z1Hsqge1OP/
seo/7HrtP7Bkh/g6VHNo9Hsqhr7U4/+x6P7J/2K6z+yf8AYqT+yf8AYo9mM4/+x39Y6P7J/
wBiuwg0eSX+Cj+wv9ikBxf9jv61J/Z3+xXYf2F/sVH/AGT/ALFZgcf/AGb51H9nSV2H9hf7FR/2F/sUAcn/
AGZ71H/ZvnfwZrrP7C/2Kj/sKgDk/wCzv9ipP7M966j+wqk/
sKgDk/7M96PscnrXWf2FUc2g96AOX+x/5zRXSf2PRWXtTnPVKPPo8
+ivROMkoqOpKACrEHeq9Sf8ta6ALHn1J59V6krnAsed+6oqODvUldAElSVXqSg0LHn1JDeVXopezAue
fUkHeqcHepPNf1pezpgXPPoqvB3qSs/Z0wLEM1S/bH/v1ShmqSj6vTHTLn2w/wDTOj/rokfH/

http://en.wikipedia.org/wiki/Base64
http://en.wikipedia.org/wiki/Base64
http://en.wikipedia.org/wiki/Base64
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TOq9FZfVqYiSbTbGb/WQW3/AH7o/sGxm/5dbaipPPrX6vTH7Ur/APCIaNN/rLGOo/8AhXuhyj5LHy/
+2lann0Vl9WD2pj/8Kx0qYfcljqOb4S6VnPmS10FHn0/ZVBHN/wDCmdOm4+1yx/8AbOo5vgna9Evv/
IddZUlL2VT/AJ+G3tDh5vgan8F9HLj/AJ6R1Xm+Cc/8Elt/38r0Dz6k8+n7KoZe1PM5fgnffweXz/00pn/
Ck9R/54x/9/K9P8+jzv3tZfvA9qeTzfB/VYOfsv8A5EqvN8K9S/54S17R59HnSf36P3hr7Q8P/wCFe30P/
LrL/wB+6rzeCZ4eZE5/6517553/AE0o8+j95/z7D2h8+f8ACHyf3DRXv+U/uR/9+6Ky/ef8
+w9oeNwzUV812f7eEnlfvNA/79yVo2f7eFj/AMvGh3UZ/wCulen9Wxn/AD7OX2p9D0V8/
wAP7eGif8tNKuY/+2lXLT9uTwxN/rIL6Oj6tjP+fYe1PdPPqSGavF4f22PB0/8ArJ7mP/tnWhZ/
tgeB5sf8TWX/AL91l7PEU/8Al2B6559WK8rtP2rvA8v/ADGY4/8ArpHWpZ/tFeDrv7niOy/7
+UfvP+fYe1p0z0Tz6PPrj9N+MHhy8+5rllL/ANtK1IfiFpV59zUrKX/tpR7U0Og8+iseDxVYzfcu7L/
v5VyHWIP+e9t/38rL61TH7M0IO9SVnw6knXzI/wDv5ViG8T3o+tUxFipPPqn9s9/0qTz61
+s0wLkHepIO9U/PqSG8o9pTAuVJVPzU9asQzVr7UCSpKj8+jz6YFijz6j8+igCxDNUlV6k8
+gCSpIO9V/PqSGaucCxRUfn1J59BmSVJVepKr2oElFR+fUnn1JoHn1J59V6koMyTz6k8
+q8HeigCx59FR0UAfmp4J/Z1u/Elr5n262jk8vzPLqv8QvgDqvgO1+1yeXc2f/PSOT/
VV7H8Gdn9lxyf9M6yP2rvG1r4V+F955nMl1+7jrjwWJxFSp7OmbVT5mvJvK/
Gqn2yP3rmofEnnf8APPzKsQ3klelVq1IVDY3ftj/36SHU+9Y/9p+1Sfa0/
wCelH1qoBuf2mnWSpPtnv8ApXPw3nnVYhvK1+s1P+fgGzFqXk/6uQx/9c6nh16f/nvc/wDfysP7Z7/pR/
aftWn9pYgr2Z0kPiS7z/x93P8A38qWHxhqUP8Ay/XP/gRJXNfbPf8ASibU/J96P7SxBn7OmdhZ/
E7XIfuarff+BElaln8cvE+myxyQa5fRyf8AXSvM7zxUmmxCSf8Adxxf8tK4fxv+2B4L8By+XfazbeZ/0zk82i
nmVSv+7p0/aB7OmfUmm/tOeNYv+Y5L/wB+62LP9qLx5D/zGZZf+ukdfnvrH/BVzwVoN15cFrfXx/6Z/
uq2NN/4LY+B9Htf3ngS+vpP+vyj2WYf9An/AKbNPZn6AQ/tdeOIf9ZfW0v/AG71ch/bZ8XQ/wCsSyl/7Z1
+efiT/gsl4E1i6jk07wrfW0f/AC0j8zzar/8AD2LwPL5fn2t9bR/8tP8AplR7LEf8vMGH1emfpBZ/t7
+IIeJNKspf+2lakP8AwUIu4f8AWaBH/wBs5K+G/
hX+2B4O+LV1cW+larH9oi/5Zyf8ta9IhmkvLWOdPNkjl/1ckdc1XE4OnU9nUw4ezPqyD/gocn/LTw5L/
wCBFaFn/wAFAtK8oeZod9GT/wBNK+S/Jf8AuSflUc0MmPuc1r7TL/8An2ZVcN/08Psiz/
b98MTf6yxvo/8AtpHW7Z/tyeC5v9ZPcx/9s6+Gv39HnP8A9NaPZ5fUCnTqH3pZ/tpeA5v+YrLH/
wBdLeStCH9rnwJN/wAzBH/37r8//no81/Wj6tg/+flQKtOofohZ/tOeC7z7niOxrQs/jx4Vm+5rll/38r84/
tnv+lSQ6lPDwZJaPq2D/wCflQz9lUP0ss/ipod5nZrNl/38rQh8YadNnZfWUv8A28R1+ZcPiSfPySS/9/
K1NN1ieb/lvc/9/KPqWH/6CDX2Z+lEOvWv/P3bf9/Ksf2zH/z0j/7+V+d9neal/wA/d9H/
ANtJKuf2xrkMXyX19/4ESUf2b/1EGX7w/QiHUk6+ZH/38qT7Z7/pX54Q/
FrxHpuRBrN9H/20qeH9pDxrpudmuXP/AH8rL6l/z7xAeyqH6EfbPf8ASpPPr8
+4f2uvHFn9zXJeP+elWIf22PHNn/zEo5f+2dH9m4j/AJ+UxH3559SQzV8H2f7eHjiH/WT20n/bOtSz/
wCChHieH/WWttLR/ZuM/wCnZn/3DPuDz6K+NI/+Ci2rKuG02Nm9ftFFP6lmH/
PsD5m+Bv7Y2pTeCNQvpLvTbKOw/wBXBP8A9M4/Mrzv9pb9tGD4zafpcCWsflxf8fFeV6PDJZ/
Cq8k/1fm3Hl/+Q64vyf8AnokvNLBU8PD94elVp/vDrLP4tWMP/Lpc5rUs/jZp0P8Az1j/AO2debzWfH3Jf+/
lEMP+xRU+rlHrEPxm0ocSSXPH/TvVyL4taHN1vo68f+x/9dajmhrP2dMv2Z7Z/wALO0P/AJ/o/
wDtnViH4haVP9zUrb/tpJ5VeF/Y/wDYjqSKzT/
pnWns6Zn7M98h8VWM33NSts/9dKsf8JGk0vyTx/8AfyvnsWfk/wDPM1h+PPG1r4J0a4nu5/8Aln+7jjk/
ey1nV9n/AA6dQ09mfTmpeMLTQbWSe+u47ZIo/
M8ySSvmv48f8FLNO8OeZpvhm1l1K8/57/8ALKvnPXte8Y/HjWY47VL6PR/M/
dx+Z+6rqPCv7HN3PaxyTp/108z91XTU+p4D95iP3lQ0p5bUmcH48/aW+IfxUluJLvVbm2t7r/
lhB+6iirh/7Au9Yuo/tc/m/wDXSSvqDTf2P+vyR/8AfytzTf2RE03+CP8A7+VzVeJPafw/3Z008uPk/
wD4QOSGtS08ByfZY/8AV8V9OWX7IsnPmeX/AN+6p3n7Md9ps3yJ5sf/AD08uvN/tL2n/Lw1
+pTPB9N8Hp5Xl7I4/
wDtnVi88BfupI9nm/8ATSOvZJvhjd6PJ5fkS+Z/171Xm8LXc38B5o9riP8Al3UNfZVDwfWPBU+gxfa4J7q
OSL/nnJ5VegfBP9t74h/A3y7STUrm50uL955c9xJXWTfDGfUv3aQeb/2zrl/Ffwfkhl/49c+b/
rP3nleVXTSzep/Dxv7wVXBe0Psj4D/t+eGfjZayR/2lLpOoReX5kE95/ra9wh8SXX/P3L/38r8g/
Enwru9Huo/sKeXj95/rK98/Zj/bq1X4exR+H/E8EupW8Unlxz101cNh6lP2mCOKrhqlM/Qj/hJb7/
n7lom8SX2P9ZH/AN+68T039qjTtSijnSyvpY5q0P8AhpGx/wCgdfVlTp1P+fZw1PaHrH/CSXcP/
POpIfGEmceRbV5PB+0TpU3+ssb6OrkPx40OY/vPt0f/AF0t6fs6n/Psz9meqQ+MOP8Aj1j/AO/
lR/8ACYQQ/wCstf8Av3JXlc3xy0fol3/5DqnN8YLGb7l9Hz/0zo9ma+1PULz4qWNlHJJ9ll/7+Vo/
Cv4kQeKvEfl+RLHHFJH+7krwrUvHljqUX7y+6/8APSus/Z78VadpvxBt/Mu48yxyV206eH9mc1U/
Sz4S6Pa3ml/vILaWP/rnXm/7YFnY+CYrOTToI7KSX/WJH/qq3Pgn8ffDMGgxxz6rHHJ/q5P3deL/
ALaXxUtfFXjyzgtbuOWO1j8z/nlXzWG/3wVM4u817zqpzan3rn4deT/npH/38qx/
a8E0XySRy/8AbSvSq1aZZoTan3qv/aP+3VP+0/
aq814mf9ZHT9qBsf2n7VJDef8ATSsP7Z53NR/2lJDWvtAOg+2/7dFYSawxX5pOaKPaGZ5BrFn/
AGb8NLO02Rxx3Unmf+1K5P8As1P7ldx48hkh0vR4JPN/dWcdcn5HvXR/
y7Ay5tN6eZHUf2PpsNak0NH2P/
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Oa5TQy4bPzqP7NT+5Wp5PlfjRP2rb2pXtTL+xf7FSfY/8AOaufLWX4w8VWvgnw5calff8AHvFWX/
Tuma+1Of8Aid8QtO+GOjfa9Sk8r/WeXXhfw9+G+u/tUeLRrOpJLY6PFJ/rJJP9bH/0zo0HQdS/
ao+KFxdzz30ejxXH+rkk/wDRdfVnhvTbXwrpdvY2KRx29rRjsd9Up/VsP/EPawWC/wCXlQPB/
wAN9K8E6XHaadax21vFHXQQ7Iap/wBp+1R/bPf9K8Cngv8An4evTNSH9170TSpMPrWf9sk5/
eRx1H9s8n/lp5uaPqxpSqmxDKkI+laFnsm/grl4byTzPkkirY03z/8AnpGc15uJPSp0/
aGpNpsE0X+rjrDvPCsE0vlokfl/9M462IZp/wDlolWPPrnNfq0DH03wTa2cvmbP+/lXJvAelal/
rLG2lq5B3qxD5nFY1P3h0+ypnH6l+zroGpSmT7DHXB+Nv2D9K8bSybP3f7ySSPy469802aetyz2Z/
wCWdZ0sdjMJU9pTqGVXBU6h8d+FfB+s/BnWY/DGuWvl/wDPvP8A8spY67T7F/
sV9AePPAdj480H7Jd/8sv3lvJ/zykryO88Nz6DdSQTp+8ir7HLc3+t0/af8vD47NsFUoVDn/
sckpFH2OP1NdB9i/2KJrNM/cjr0/aHknP+Sn8EdHlPWpPZ/wByo/
sf+c0e0Mv3ZnzQ1JZzSWd15iSSx1b/ALOkpYdM7ZrT2vszKrV/dnqmg/
GDWdN+CNxaJPKY4riSPzPMryfXtSu9Yv5LueeWWSX/AJ6SV3Ggw+d8L7iPzI8xXkkn7z/
rnXF3lmfNrpp4mpTpnNhv+nhT86TjY8v/AH8qP7ZP/wA/Ev8A38qxNZ0VzfXah0/uyv8A2ncf8/dz/wB/
Kkh8VarZ/wCr1K5jqOaGTrVeazk837nNafWqgfuzUh+JGuQf8xW5NSf8Lg8R+V8mpS/9tI6w/
Keo5oZPN+tZ+1/6dlGs3xj8Tqcf2lj28uisSWHD80UvaU/
+fZznrvxOvJL3VLOCT935Vv8A8865eftXQfEibPi28EnMkX7usOu2qc5HUfk/9NKkorEftSOjyPeiiucsjm2
WcXmSeXH/ANdK+R/2ivi3P8WviCPD9jP/AMSO1kjjk8v/AJayf8tK9w/aj+JEHgT4aXEfmeXeap/
o1vXzH8ONN/s26+1fvZZP9Z+8rrp1PYU/rB1YL+Ie+fBmGDwfoMcEfm/
uq9M0HXvtkUkleJ+G9ReGLzP3v73/AFkdemeA5p5v9Z/q/wDnpXzfs/
afvKh9TTq+0O4s7zzqsTTVl2fr5keauTXkFnF5k8ltbR/35JPKrT2oe1LEMMk1XItH/
wCWklcXqXxy8M6DL5cmqx5/6ZxyS1zesftaaHZ/u0+0y/8AbvJR9WxFT/
l2ZfXqcD2SzhsYedkctbFneWMMv7zy46+W7z9szTvN8uO1uf8AtpHJUmm/tjaPNL5c8n2b/
v5FWdXLalQ7sNm9M+sIvI/gqSbyJq8X+Hvx4g8SQxyWs9vLH/
z0jkr0CDxJ+6jkMn7uWvIq4KpTPfp4mnUOo+x/
uhsohhk/6a1T0HxJBNjzDVjxV4kTQoo5JJPLt5ZPL8yuapTNTQhmk6VqWZnEX+rjNefzfGzQ9H/192ZZ
P+mddh4a+KmneV5fmf62uLE0zT2pqQ6l+98uRKx/HmgprFh56J/pFrH/AN/
a6SHWLHXvuZ8yo5Yf7lZYLE+zqHFmWGp4vD+zPG/
PqOftWp4k0efTdUuI5E8uPzP3dZ9fomHq+0pn5vV/d/uyvRj/
AGKkqOun2ZAUUY/2Kk+WikY1TpPCv774fahB/wBNJJP/ACHXLzQ11ngnzJvDmoQeZ/z0/d/9s64
+aYy1pVpnNTI5+1V5oU/56VYm8zmqc01Z+zNyOo5+1SefVeaapJ9oR1HP2omvKjmm/
wCutBIxpuaKqSXeHIOeKKCvanr3jyyk+1fbp/8AWXUn7yufr6M+OX7N8kPhe4n0eTzZLX955EkdfN/
nfva7/Z+0p+0pnL7UKKj8+jz6z/hmhJP2qOjz6x/GviRPB/g3VNSk/wCXW3kkrL+JUMz5H/
ab8dyfEL4tXEEF1Hc6fpXmR2//AEyqxoMP7q3k2eX5vlyVwej3n9p39xfSJ/x9SeZXonhWzzYeX/
yzirXMqv7z2Z7eGpnYeHIZJpfkTzZJf3ccdeuaCYNB0bz7uSO2jij8yT/plXD/AAx0FLPy7uf/
ALZ1x/7UXx4g0Hwv9ktcyxyyeXJ5f/LX/rnXiU/3+Ip06Z69Wr7CmeoeA/iR/
wALU16PTbXzbKz+zyXtxP5f+tj/ANX5f/TOtDx5/YHw30b7dPa21zcS/u4/tH72vJ/2LfGsHiT7RqU/m/
utHkjk/d+VF5nmf6qOuT+PHxIu/GHiO4g8z/R4v3fl/wDPKvbq06ftPZ0/4dM82rVOX+IXxm1Wa/
kjgnjso4pP+WEflV5nr3xa1ma6+TUtS/7ZyVqaxCk0skcn/LKub1KG1hMmfLjk/wCelFSr/
wA+6ZzVaZn3njXxBP8AcvtS/wC/klbHg/
x5rn2n95qVz+6/56VnzalBeRfuX82iz1LyZcSJXm1cTU/59nThqdM94
+GOsQaxHbyX0FtHJ5n7ySOPyv8AlpXtHg/xTqum2v8AxLtSub6zij/1E8nm183/AAr17ysSbP8Aln/
z0r2Dwr48g8N38Z/5aSyR+XHXN7X2lQ9v+GeueFf2tPAmmxW8F94jsrK4/wBXJHJ5kssUlZ/xg/
aK0DxtFHaaPrltqXm/vP3cn+qrH+A+mv4k8OfbpINNjtxcSRx/6PHJ5v7yuw8bfBO18eaD/
wAeNlcyRf8ATv5X/ouvIqfV6eI9n7Ooe/7OpUw/7s8H17UtZ1iXz7FL6WP/AJ7/APLKuT1/
x54jh1XzJPE+m2UkUn/QQ8qu8/s2DTfgZbRpJLF9g1S4tri0kk/49ZI//tdeLePNHg1KXy/
tf2bzf3nl16WGxP7w8CpTxB7D8K/2kPE/hu//AHnjXRL793/y3vPN82vqj4b/ALXUGvaX5l9B5vlR/
wCstJPN82vzn8K/DFJr+PZff+Q67zQfDc/gm/s50k/eRf6v95RVy7B4s6cNicRT/iH3p42
+KnhzXtL89NS8u8i/1iTxyRfu6y4ZvOijk/1scv8Azz/e1ofBL4nJ42+Bmn2N9Y6brkcUfl3kE/72uk8E/
DHwPr2qXEFrPfeG5JZPM8vzPNi/6afu5K6ct9nTp+zPm82/ie0OPqPz67j4wfBPUvg/
a293Pd22paXdf6u7ST/v35kf/LOuD8+vS/dnjklHn1X+2f8ALOo/O6bKozOz+Hs6fZdU/
wCufl1yE376LPNdh8Gf9MuryP8Ae+XLH5cf7uuX8YaPd+G7
+SCdPL/55/8ATWOpq1f3hmZ3nSf36qTTUTTVX+2e/
wClUdATTVXmvJP+mdRzTVX+2e/6UGZY87zpf3lRz9qj+1/7FFnN9slqf+vhnVqly0tHmhDHqaKtLDxRV
GZ+oWpaCk0X3P3Zr4r/AGovhingPxlJd2sEcen38n/LP/VRSV98Xmm/uq8P/a0
+G/8AwlXw+vNiebcWv+kxyVvgvcqezMva8lQ+I5
+1H7z3lzRP2qPz6MT+7qezOn2pJXk/7YHiT+wfgtqEaT+XJf8A+jV6xXzn+35q/k+HNDtP+Wkt5J/
y0rPD0/3gf8vDxfwTZwQWskezzf3kdeweG9BTWJY9nlxx14/4Vs5PtMn/
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AC18qPzK9Q8K+Kk02WSRP9X5f+rryMb/ABD6TDnYfEjx3B8PfBslvBPHbSRRyf8AbKvm/wCDPg+7
+LWqf2lrL3P9h6X/AMtJP+WslbnjbxhB8SPFEljPP5en2tx5lxJJ/wAtf+mddJN4qkm0GPTdOtY7bT4o/
LjeCj2vsKfs6Z6VPDVP4lQ6jwf8QrWz8USaakHlxy2flxxxx/8ALSvJ/Hn27Tb/AFDzE8u4
+0Sf6yOStyHTbuG/ju4J5Y7yL95HJ/y1rtIfjZ4qmtY7TUpNN1K3i/5+9Pjllop4n2f7unTM6uG/59nz/
o+g32vapHB5csccsnl+ZJWx4w+Fc+j2EkcmlR3MY/d+ZHJ/7Ur6I0f4nJeReXP4c8L/
APgvqS81j7ZnyPD+gS4/56R13fXf+nZw4nBVKh8l+FfBP9sXVnaJayxx+ZJ9onkjqPxJoKaPrMlon72OK
T/WV9OaxpqTH954c8Nx/wDbOuT1iax0395J4V8N3Mnl+Z/x7yVlTxNOpU/hmv1LEUzy/
wCHsN3pssnmJ+7Pl1654O+D19r11/
aX9pXMcl1HJHHBJ5kXlVf+Ht39sh8xNA0TTY5f+edvXrvgPTpIf9Ok8vzPL/d/u6z+s+z/
AIZ24bBe0qfvDoPhv4bTSNBt9Ng/497COOKvRNB0390Y+9cnpE32yXy0rpLPUoNH/d+ZKc15GJ/
eH2WHOT+P37Ov/CVfDnxRd6PJc/bJY4737JHH5sXmR/6z/pp/q6/
PvWNBns7C4u9ksvlV+tHhXUk1O1jk2ebXyf8AH79kXw5Z+Lbyx0rxHZab9q/eyWGpSeV/
rP8AnnJRluZU6ftMPiDxMywXs/4Z8j/D281K81ST7Layy+VH+8/
d16hZ+Np4ZbePUk8vyvL8yOOP97Xonw3/AGG9Zs9Ziu0u/
t2lyyfvI9NvI5fNj/6Z1ofHj9mnVYYtPvtH0DUrKO1j8u48z975tdNXE4epU/
d1DLBU6ns/3h6J+yvr6QX8lja/6THL5f8Aq4/Nlr1jxJpv2O/kjk8uWSL/AJ5181/si69d+D/iro9xPPLGbW4t/
Mr9KP8AgoF8N9G/4Zuk+I2jppscmgxxySeR/wAtY5P+en/bStfrP1TEU8P/AM/DxMyp+0xHs6h8f/
Ej9pBP+FX6h4Ru01KWOW3kvbO78v8AdS+X/wA85P8Alp5dYfw98VQeKvBGl3cE/wBpjlj/
ANZXgem3mq+PPFGsXcl9cnR9Ls7iO3jkk82KLzP+ef8Ayzr2D4Y+G7X4b+CNP0a1T93a/wCs8z/
npXt4n2fs/ZngYnDez/d0ztPPqT9/efu4EMsg/
wCedZcOp+dXtn7NPw3TUr+PVb6P935n7uOin+7p+0OU6j9nX9nXxHDYR3ckNtH5v+r8yStD9pz4D6zZ
+Df7S+y+bJaf6zy/+edfTHw98NpZ2sUH/
PKu8m8NwalpclvcJ5tvL+7kj8uvIq4mpTxHtKhmfkfqPmQmT955dZc03/TSvpT9tn9lGT4Y6zJrOlJH/Zd/
J5n+s8ryq+Z5vLz89e3+7nT+sU/4ZpT9mRzTVHNNUc37r3qP/
W1xVQDzpP8AVpWxo9n5EX7yT97Wfptn/
sR1sQfuYs5jrT2v7szLyzcUVGsiMM5oqgP13m/1Ncd48s01HRriCRPNPlyV5v4P/
b88Ja9mPUkvtNk/56SR/uq7yHx5pXjzRpJ9K1Ky1K3/AOekElY+1qU6n7ymc1XD1Kf8Q/P/
AOIXhv8A4RvxbqFj/wA8pKw/I969Q+P2j+T8S9QkSQnzf3klcH/Y9elifZmtMx5of3VfMf7e0JvNe8NweZ/
z0k/7aV9UTWcn9yvmf9vCz+x6z4bu5E/56f8AfyjDUzow/
wDEPK9Hh+xwyf8ATWuf+JPjA6PYSWkEkv2i6/55/wDLKOtibUrXTdBuLu7njj8r/WVX/
Zv+Fd38ePG9xrl35sen2skckfmRx+Vdf9M68Sn/AM/Kh9Lhqf7wk+D/
AMDdS8beXd33m21nLH5kf7uvbNN+GP8AY8R2Qeb/ANNK9Is/B8Gj2scCQW3lxf8ATOtCz0hP7kfl1w/
vKh7X/Xw8v/4QOe8+TZH/AN+6jh+FdxDL/wAu3/fuvZItNSGL5EjqvNCkP8FHs/
Zjp06Z5nZ+Cfsf+sk/8h1JeQwaba+Yida7DX/Lh/dolc3NpE959/y/Lrmq+0/5eHb9Wp/8uzg/
EmpT3l15aJL/ANM/L/1tSaD8N59Y8u7nTy4/+ecn+tr0DTdBgh/ebI/MNXPJ8r8a6af/AE7M/
Z1P+Xhz8Ogmz8v5K6jR7NLOxjku5/s1Yd5q6abL5n+t8qvF/wBo/wDaun8CWtxYad5f2yX/AFez/
llR7OpOp7OmdtX2dCn7SofRE3xIsdBi/wBFfzZP+ek8f7qjTPjBBrEokn/4
+P8AnnHJ5VfnQPjB4z8bazJsvr6WSX/lnHXs/wAM/EmuQ+HbOPUZJftEX/PStcThvZ0/3hlluOp1z78
+GPxCsfN/1nlxy/8ALOtz4zfCux+JFhb6lBze2Ef+s8v/AFsdfB/iL9qG+
+DemWQhhNzf3fmSIXkzFXuH7Gn7Yt98U9QubfWIYrfEf7wx18tjqeIp/
wC0Uz6WlTp1P4dQ7zQfCtrZ+Wf+WkX7v93Wp4k1jXNH0sHTr6+j/
ef6zzK3NS0e1vJJJErPmmSGWO3kkP8A20ryfrPP+8qGfs6Z5/8A8LC8R6bf+f59lfSeZ/
y92cctdJ4q+P3/AAnngOTSvEGj219by/vbiCS4kitZZI/9XVzUvhKmpeZPa/6yWTzPLryf9qLTbv4V/
Cq41J0lt5Iv+ef7uvby3E+0xFOnTPn8yy6meb6D8SIPid48/sPQ9K0nRPDel/6TeRwSfaftUkcn/
LSvXIdS87/lpzXh/wCyvpv9j+DbzUpJ5Zf7ZvPM/wBZ/wAs69Uh1JK+1p/
xD4DG1aftD0j4b6PJ4q8R2cH73y5f9ZJX2r8HvCqWcUdoicxR18xfsi6D51r/
AGjslllluP8Av1HX2J8K7MxSySf89a6sT/E/dnkVap654Jh/dH5P3legaPZ+dFXD+Dv9uu40ib/V5rmqU/
aGZzfxm+Fdj8TvAWoaNfQRyx3Uf7vzP+WUlfkv8YPhjd/Dfx5qGjXcEtv9gk8uv2gm/fRZ5r4X/wCCmfwZ/
wCJzp/iO1tfNklj8u4oynE+zqVMNUND4XmhMP7v1qPynrqJvB84l8ySCs+8037H/
rJDmtKpr7Ur6b5kMVaFZ/8Aqq4v4kfHhPBMv2GCCXUtUlj/ANR/
yytf+ulZ+1/59mX8Q9GW6RhnMdFfP8v7UupqwB0uBT6CTiitP9oD2R9tTeG57OtDw3eX3hu/
jntZ5baSvZJvh7Yzf6zzasab8PdHs+fsvmyH/npXV9ZM6eJqHnGvWd94wm+1zpLLJ/z08usabwfP/
cl/7919AQ7If4I/+/dE2yb/AFiR/wDfusvrNT/n2ZU6p83zeD5If4P/ACH5VfLf/
BSbwrJpujeF77ZHHH9skjr9GPGGvaV4VsPtepSWVlb/APPSeOvlP9t7WPDP7Tnwl/
sDSn8vUIrjzLef7P8A6qjBYmn9Y/efwzpw2GxHtPaezPzX8eXcmpXVnodr+9
+1Sf8ALOvqz9mnwqnw88EW9p5Hl3EUf7yuf8B/su2vw3uvt93PHqV5NH5fyf8ALL/rnXYabqf9kXUmz/
V/8868jHVadSp7OmfbYan7M7z+0v8AYqP+3vIx5nf/AKZ1hwax537xJM1oWc3/
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AE0op06Z01KZ0EN550Ucn/LOX95Uc14kPVM1nzXn7r/WVl6lrE/P+tNdA6ZY1ObzvwrPqPzvN/Ck8n/
rrXOejTqkv/LP95WfNBJNLlP/AEZWh9j/AHVR/uLOL95JXN7UKlU87
+Kl5PoPljzP3d1Xz38VPCEPja6Ek8n2byf7le+fEjxgn7yBEtrn/ln5kn/LKvN4fCsl5dSTyfvf+mdelhqf/
Lw8jHZl7Sn7M5/4f/DhPCFjGhtTHcf8tLj/AJ61654b0eDUtLt5JEzJ/wA86r+FfM1KXyD+7kij/
wCWkdR+Kbz/AInPlwJ+7i/dyf8ALL95XNifZz/iGeGxNSmV/ip4Ptfib4Ts4L421t9l/wCPeSP/
AJZV0H7LvgO18B6pJHazyyyS/wDPSq+seG/7S8B+ZBJ5WoGPzI4/+mlcn4J8beIPCsUkdjP/
AK395JJ5deBicNUnT9nTPsspzLD0P4h9p2epT3kUf+tq7/ZqXn+s8uWvmvwf8VPFVnL5l3d/9s/
LruIfjZfab5fmJHLJLJ5ccnmeVXz9TBYinU9mel9ew9Q948N+FXhl8xJJf+/
n7qrnxg+Etj8Zvg3rnhy+SPzL+3/0eTy/+WlcX8MfjAmpfu7j93IJP+Wlemax4807R7D7XPdx20f/ADzk/
wCWtc3talPEU6hzZlT9pT/dnw3Z6OnhCwj0pP3cel/6NHViG8r0zWPgmnjzxbqF3Yzx2VndXH+j/
u65fx58FNc+HstvPJB9us5ZP9fB/wC1K/TctzLD1Kn8Q/JcdgsRT/iH1h+zfo6aR4N0+D93/q/
M+SvoTw3420fwrF/xMtSsraP/AKaSV4v4V8B+d4S0+eCTzbe6t45I5I5P3VR3vw3k/uR1r7WnU/5eHm/
VqZ9MaP8AtUeANHHlyeJ4/wB1/wA8466DR/20vhl5scf/AAk/l/8AXS3kr4zvPCskP+sMVZ82g9609lh/
+flQ0+rUz9FPCv7RXgvxhLHBp3ifSbmSX+DzPKrj/wBq7R4PGHwl1jy5I5fKt/Mjkj/
e18Lw6P5MprsPDfxO1Lwro0limqyy28scnmRzyfuq5sTgvZ1PaYeoZVadM8nvIUhiI8uuP8Vf8fUkZ/1ddR
qU3neZsrk/EkH72SSST95XTVp+0/eHPTOX1Kb7HFJJJ5fl+XXj8MMl5dSTyZ8yX/
WSV6p4q8yawuIP3fmS15v5yQy3En+r8qOsToPLfiNpUVp4olUdCin9KK6HUfB//
CVXTXzw4eb7w96KcaeiGz9kYZv3VWIZqp2farldNI4iSj/lrUdRzTeVFIK0/
wCnYofxD89/25P2xp7P4l6hptjB9u+wSeXb/vP3X7uvO/h78VPE95f2d3qVrHLp91/
rPL/5ZVx/7SGmyf8AC39YjnTpcSeX/wB/K948HeG7XTfh9pcey2lk/
wCWdPNqdOFSnh6Z+rYn2dOnT9nTK+vax9s/5af6qvO7zWJIbqSRP+eleieNtBTw34cku/tFvL/yzj/
eV5X5P72vIPExNU6jQdek+1Rx+Z/ra6jTdRSaX/WeX/10krzvTJvO/wCmdbGmalP9qkjz/
qq1p0zP2h3E2pIP3fMtRww+d/rErDs9eSGWPz/Lj/2/
Mrch1JJovkqzop1Qh0zyfeqepXnk1J53P3/3lc34w17+x4pJP9b/ANtK56ntDp+s+zJNY8ayabYSeX/
rK4fWNek1668+ST95/wA9Kx/EniSTWL+SSSSX7PL/
AMs6w7O8k82TYkv72tadP2Z5NXE1KhsTQp5uJD9p/
wC2dWIdHSylku7uTy7Py/8AV/8APKqc3iqx8E6X9uu5PNk/5Zx+ZXmfiX4wT69dSSP/AKv/
AJZxxyVlV9p/y7PSwWW/8vKh7hpvxU0DR5fIkgll/d/6+Py/3tWP7S8M6xEJ0vpf+udfNf8AwsKP/npT/
wDhYUkMXyT3Mv8A1zrzauCqf8uz62nTwf8Ay8pn0zB8TtAhHkeRLKaIfEng6aX9/J9m/wCuf/
LKvmOHWNV1KX9xa30v/bOSq+v6lrOmxb54Lny/+mlcVXLan/Pw0qVcH/z7PqzWNNsZrXzNOu45bT/
npXB6x8VIPDf2iP7dnyv9XHXz/D8Ttc02KTZBLHH/ANdKr+DptV+J3jKOx/1ccsnmSf8ATKunBZdU/
wCXlQ+bxOOp06n7s+yP2V9H1n4wSXGufa47LT4pP9Zcf62X/
tnXuk+g+dL+8n+3Sf8APSSsf4G2cHg/4X6fY2uY7fy/
+eddZZzJN+82R1lVp+0qe0D+0qlT92WNB0eTTZY5EkrsLOyg1GwEF2kcscv+sjrn7PzJvetzTobuGWP/
AFctcVWnUpnV+7qUzP1L/hO/g+ft3gDWY77TxceZceHtW/exf9s65eb/AIKrT+Cbr7D41
+G0ttef6uT7JeSRebJ/20r1izh+2Rf885K5v41/AHSvjz4NOm6kkf2yL97b3cn/
ACykrpw2d4f2ns8xp/8AcQ+ax2U/8+zi/wDh7R8ObuLEngvxJH/1zuLeWqf/AA8a8M+JIv8AQfCWpeX/
AM9J7iOvh/4y/BnxB8B/GVxpWs2sv2fzP9Du4/8AVXUdbnw9lSGW37p5dfW/
Usv9n7SnT/8AKh83Vp06Z9gaD+0tP481mO0sdKsrLzf+WnmebXSTalPef6ySWWvA/
gzeed4ns9h/5aV7xDnyv9ZWns6dP+Gc1Up3neuX8Sf6r95XWXneub179zFJJ/37rOqZ0zg/
EmyGw8ySSvG/FU13NLJaWsksv2+4k/7ZfvK9g8bf8gG4kT/WV5npsN3pus3Hnyfu/tHmR1lS/
wCXhpTOpTwzZaZaW8EnmuY4gA2I23D1zRXDeP8A4qRaLraQF5d3kq5+pJP9aK5Y4bRG31Q/
WyzvMceZH/38qx9r/wBivy7s/iR4jsv9Rrmr23/XO4kq5oP7QnjWG6uI/wDhKtb8uKT93/pFen/Z2I/5
+HB7Kn/z8P0887/YkqvNeV+dcP7VHjyH/mZ9Slx/z0/e1qWf7Y3xDh/5mCWX/tnWv1LEUzWnT/59nH/
tdeCZNH/aWuLTZJHHLef6z/nr5ld5488Yf8If4Dyn7248vy/L/wCmdYfiTxJffE7WdP1nVZ/tOofaP9Ikrl/
jDZ32sazp9jamX/SpP+mnlRVlmVX2+I9ofqNL/d6ZJ/wsJPEng2SDyP3kX+sk/wCev72sPyfO/g/8iV0n/
CsU8H+FpI5Lu2uf+mkdcvZzJ9qkj2f6qSvN9nT/AOXZ8/if4hY87yYqks7ySb61H53m/hRpv/
H1J8nmx1pT9oc1UuTTedF5fmVoaP4kkspf3kksuf8AnpWfNsm+51qO87xyV1VapnTqnWQ699si8yvN/
idef2ldeWn+s/5aV1kM32O18uT/
AJZVxfjCLztZkk/561zUv4h04n2hz2rzQQWFv+88u4l/1n7usTXfHlroNrJPP5Z8qtjWNOS8EeysPR/2dZ/
G1/8Aa9Su5Y45f+WccdHsqdT/AJeHThqdM831LxXqXxO1S3ggSWX/
AKZ/63yv+mldhoP7PaXkUcmpSX0snl/6uP8AdV7R4P8Ag/o/gO1/0W1jj8393/z1qv4k8SJo/wC7gg8uP/
pnWVTE/wDPs9unVp0/4h5vN8MdK8Nx+ZJp0cX/AE0k/e1Th1LR7OXy4Ps3/
XSOOqfxI8SXesSyRweb5fmfvK4uz+11zVcNUqfvKlQ6f7bw9P8Ad+zPYNN15LyLy0k83NU9e0e1lijkn8
uX/rpXD6PeTw5/1tak2sTzQ+XJmvNq4apTD+1/aGH8SPI+y+WiR/
upP+WddB+zT4V8nRrzUuftF1/6Lrz/AOIWpf6TbxpJL+9k/wBXXqngPxVB4b0G3tMx/uo/
+Wlevhv3eHPn8TT9pU9ofXHwx1hD4I0+NPNl/d12nhqbzv4D+9krx/8AZv17/hJfCVv/AM8/M8v/AL917JD/
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AKH/AKuszX2dM6iGb7H/AAVoWesJDzmuLmvJB5knmS8U/SJp/
MH7yWuWrhvaBTqnqOm6x533M810umzJNF+8SOvPvDd59jh/
efvZK6zR9SkvIvM8zy68DE4Y6frJT+LPwx0P4neHP7N1zTo7m3/5Z/8ALLyq+N/2lv2Xf+FD6p/
bOgJLc+G7/wDdx/vP3trJ/wA86+7POS7tRH5kZrg/id4DsfiF4XvNDvv3dvdR/
wCjyf8APKSssDmVTCVP4n7syq4LD1Kf7w+P/g/
qWPGVnGn+r8yvoyH97Xy/4V8K33gP4tf2VfebHJa3HlyV9URf9s/Lr9I9pTPgMT+7qFOb/U1zfiQST20n/
wAbrrLyH919yuf8SQ+TYSSc1rV9mZ0zz/xJD5thcR7PNxHXj15eT/b/ADNn+tr23UofPP8ArOleT/
EL4e6lpt/Jd6dJ5tnN/wAs/L82WKuH2f7z2Z2
+19mePeNTJ4k117lYduVCke4zRXSTaNqFvcSI9tcghjgeX2or044XRHF7U7n7H53FZ+g/
vopJD9yWSSuo/s2SH95WX4b0fydMj2JLXbVpnDSI4YU61J/y1rQ+xf7FH2P/
ADmj2ZrSNzwref6LXaeG9SkmiuI5/Lj/
ANXHHJ/0zrzeGGSH7nm1T1jx5rnhuWP7LBHcx/8ATOvn8bgqn/Ls+/y3HU6
+H9nUPUPElnaw2Fx5nm/vY5K8Xhm8mXH+trU8SfGDUptLkgntZZfN/wCedcvZ6xJeeZ+4/
eeX5lc3s6ns/wB4Z1Tc/tJJv4KsaPeJpsUnmd6w4dS/56JVwXnnRUUzlqmpeakhl8xP/IlY95rEkNh5/
wD6Mqneax5MVZd5q8k0XlyT/u/+eckleoZm5Z66byL/
AFlV9S1JJpPLkrl7zWEhHlolRw+JJJpfuf8AkSuGqdB3Hg/R7XWB5iSebH/
z0ruLOzTTYv8AWebXnfhDxJ/ZsUkf7397XQf8Jh53/POvPqndTqmxqWpf6z/nnXH6xZ/
bJZJP9VWxDefbP+edF5DBDFJ5n/POtqdU19qeZeJNB8+KT9x5vm/9NK5D+zfJl8vZ+8/6516hqU0EP/
LeOL/
pnXPaxeJ5vXza0qnAc5Zwyf3PLqxeQpZ2vmSeVRqV55MXPl+ZXF+MPFTw+ZB5n7zy64apt9Z9mcf4q1
L/AIq2zj3/ALsSRyf+RK90s/CsHiTwv5mzy5JY/wB3JH/
z0r5j8SXnn6p5nmebX0B8IPFVxqXgm3jtfL82GP8A56V6RzU6vtKh7B+xzrE/huHWNNnn/
wBVJHJbyf8AXT/WV9MabqUk0X7zza+B9N8Va58N/G/26RLb7PL+7k8z/nnX1x8MfFU+vaDHOkkfly/
vI5PL/
wCWdcWOp1KdT2h69On7Q9QhmTpWhZ/6HXP6DZ+TL5kkkfmVsefWftfaGWJpmxZ6l53NbFnrEkMX
+s/7Z+ZXH2d4kMuDJWh/bFc1XDHN7U6yHxh5PXy6JvFUF5KPMklrk5tT71Tm1L97/
rK82pgj0qeJLHxO+EunePNUs9ZtfLj1S1/5aSSf62rn2O7h/wBZBUdn4jkhiqSbxJJNF/
rK6aeb4ihT9mebiclw+Lqe0I5oZPKPyVh69F/
oskkhlrYh8VecPLk/5a1T16FLyKTZJ1rtp8QU6lT94ebjuHMRQp+0pnn95Cnm5NZ81mk33K1LyzPm1H
DDX1NKpTqHz9UxpvC0M8haT7xoroY4YyoyaK1OM4PUrPydLuH/AOeUdU/Dej+TpdnH/
wAtDHXSeMNNMPhe8d/9X5dWNN0dPsscezy/3f8Aq69+rTp/8vDlp1THh0c/vPkj/wC/lH9me9dB/
ZP+xR/Y/wC+/wBXWXs6YU6py81mn9yq80MmPuc11E2m/
wCxVb+yJP8AMdZ+zNKdU5T+x5JpP9XHXF69ZyWeqXEfP+sr1j+zf3vv/
wBc68z+Kmjyab+88zy44v8AlpXkY6mfSZSc3NqX+lSRyf8ALKq82pdNhrm9S17yZfkn83/
rnWfN4wk/1ea8T2R6VWqdBNrE95dY8yjUrzyoo/3n7z/lpWfpuvQeV+8/1tXJpkvIvuV3e1D/
AJdmXDN50oNSG88mKqU2peT5kf8AqzWZNqUnm/vJPNrnqmXtTrNB15IYpI/
+mlaE2vZi+SSuDh1PyfU1JFr39xKkzq4moeoWfjCDRzHHIkssnl/8s5Kr698SEm/dp1rzubXs/
wCsT95/0zou/wB1YR/
vPLkrb2Ye1NzUvGCTXX+vll/7Z1j6lryXnyfvc/8AXSufGpSedJ+8qvDrH+ld6x+A09qampalBDD5f+rk/
wCulcP4r1KS8uvMkT/Vf8tK2NYm8663+ZXF69qXnTSfvKzqmftTm9XlJuj7V6D8BPiCnhq88iT/
AJbfu683uj5tyT61p+HLSSaUbKAw38Q+sNS+y+MNKjn8zzfNjr1j9nvxUkPhKOxkkMclh+7/AHlfH/
g/4qX3g+LyLhPMt5ZP+/Ve4fBn4qWusarJBB+7+3x+Z5dGOp/
uz6TDVaZ9Qab4xSzik2Vn+JPHiXnlxwSS/wDTSvP5te/0X/
pnLXJzeJJIdZk8ySXy68mkFWrTqH0B4b8SSebHHJJnza7Czm/dfvO9eR/D3Uv+EkiikM/m/wDPT93/
AKqvV7P/AFRrqPKqizan5PvVOa8kqxeQyQ/Wsu8715tUumP+2P8A3DS/8JJJD+7rPl1JP3lV/
wDlrXBiXTqHdTqnQQ6950tWIdYS8781zcv7mTzEkqOHUpIR8leTUp+z/hnt4arz/
wAQ0PEkXky+ZJ5v73/
v1WfDDVie8k1K1kjkeWWqej3iQyyRyfu5Iv8AnpX2WQY7np+zqHwnEGW+zxHtKZoRQkJ3oq0nSivrP
anzBzPjDUtO1LRvITUbLzJZI/M8z91+7rcs4YJvuTxy/wDbSvM4dnXy481Idn/LT/yHXwv+veIP6PxP0fqf/
MNiD1T+xvO4zmo5tM7ZrzeHWLuEfJdy1ch8YazZ/u01W52f885K7cNx/T/5eHzeJ8As0p/
w6h3H9mpDFVObTO2a5v8A4TzWSMyXfm/9s6P+E81Lzf3n2aWP/ppHXpU+NsPUPIxPgpxHT/hmp/
ZidJK83+J2jyfarj5P+ekldp/wnk/SS1tpf/IVc/4qvP7e8yfZHH5v7uSOP97Wv9v4fF/
wzyavB2aZNT/22mfLfjbR5NBupNn+rrm/7YzL+8r3TxV8PYNflkjT/WSx/wDPSvK/GHw9/
sGWORPNljlpfGeR7Ux7PxInm9a6Cz1jzovkrj5tBkirQ0fzIf3fPl1FWnUOmlVNiaWeaX95JWfqU3kxSVY
mvKy7zzJvel/18OapVMe88SSebUkHiuSH1qPUtHT+5LxXN6l5kNdNOmc/
tToP+Ekk83zKJvFUnl58yuPm1GSH1qvea9JN+FP2gzsP+Ek86KQJ/
rKz5te/56SVy8OpSdZM0TXlcpobk3iSSbrPLxWHqV4k/vVf56jn7UAQSsRiu0+E+kPqc0mK4d8lvpXp/
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wCzfMZtZuIP+Whj/d1r7TqTgv3mI5Dc174e/wCi/
In7ysP4V6xrmkeMrOx06T955n+rk/1Veqaxshl8uSs/4M+FYJvi/
bzokfmGOSSOj937M+gxOGqUD2AaxPZ2HkX0n+kRf8tPLrCs7xLzVPL/
AOetbvj2z8618/8A5aRf6yOOP/W1x+g3kcOvW/mSf9M682nT9mcXtT0jwT4lk8N6zHInl/6z/
lpX0B4b1hNYtY50kjl/6aV8z+ckv/PWvRPgb4w8mKS0nk/1Unl1pV/h+0pmn8Q9sm2Q/
vHzzWPqX+mf8tP/ACHUmmTJefvPM/d1JqWyaI14mK9oa0jn7yH/AKaVH9sSGX/
WdKsXkL+b8nJrPmh8mXzJK4vancF5qXnY2SdapzaxJDEP9XzRNefu/
L2Vn3k0Hm81zVTopmhZ+I5PN8yT/wAh1cmh/tiXzESXzKx7LZ+NalnqUln5X/
POinVqUKntKZrVp08RT9nUHf22dPZoprW4Minknq3vRVvyIL3EkqYc0V7f+srPm5cNK7P/2Q==</
IMAGE>
      </item>
    </data>
  </cardDocument>
</cardPresso>

Appendix B.3 - AutoPrint

 One of the advanced print  features  you can use with cardPresso is  the ability  to automate print
jobs and use external applications to run custom print jobs. This feature is called AutoPrint.

For these purposes cardPresso allows you to use the Windows Command Prompt to run print jobs
you have previously prepared.

The possibility to use the Command Prompt to run customizable print jobs allows you to create .bat
files with your custom settings and run those .bat files whenever you need.
You  can  also  use  external  programs  to  run  custom  print  jobs,  either  by  running  the  cardPresso
AutoPrint commands, or by running a previously saved .bat file.

To work  with AutoPrint,  the card you are going to use  must  be  previously  saved  with  your  printer
settings configured.

Appendix B.3.1 - AutoPrint Commands

 Below are the commands used to interact with cardPresso through the command prompt:

/(P)RINT - Print

/FILTER:"data" - Conditional Print Filter

/CONTINUOUS:seconds - continuous printing with seconds delay

/SHOWPRINTDIALOG - Always show Print Dialog Box

/DBFILTER:"Filter" - where "Filter" is the equivalent to a SQL WHERE clause

/SAVE:"optionalFileName"  -  Saves  the  document  opened  in  the  command  line  applying  all
changes made by Print or DBFilter
If optionalFileName is specified, then the card document will be saved with the new name.
For example:
/SAVE - saves the document with the current file name

/SAVE:"D:/Tickets/newCard.card" - saves the document with the new file name
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Using the Save command with a filter allows you to preview the card fields filled with data that  meets
the determined conditions  before printing.

/EXIT - Forces cardPresso to Close & Exit after printing

The syntax for the /P print command to be used from Run or Command Prompt is:

"c:\Program Files\cardPresso\cardPresso.exe" "c:\cP Test.card" /P

where:

"c:\Program Files\cardPresso\cardPresso.exe" - cardPresso's executable file location

"c:\cP Test.card" - card file location

/P - print command

note: cardPresso's exectuable file location may vary depending on your operating system and the

location you selected when installing cardPresso.

The card file location is where you saved your cardPresso .CARD document.

Appendix B.3.2 - AutoPrint with Command Prompt and Windows
Run

 AutoPrint commands can be run directly  either from the Windows  Run dialog box,  or from the
Windows Command Prompt.

To run an AutoPrint command from the Windows  Run dialog box,  open the  dialog  box  trough  the
Windows Menu Start>Run type the AutoPrint command in the dialog box and click the OK button:

To run an AutoPrint command from the Windows Command Prompt,  open the command prompt
trough  the  Windows  menu  Start>Accessories>Command  Prompt.  And  type  the  AutoPrint
command in the Command Prompt window:
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Appendix B.3.1 - AutoPrint Batch File

 AutoPrint commands can be stored in a batch file (.bat) for later use.  This  way,  you can create
as many batch files  as  you like,  each with it's  custom  settings,  and  run  your  desired  file  with  the
desired settings whenever it's needed.

You can create a batch file in any regular text editor like Notepad.
Simply  create a new text  document.  Type the AutoPrint commands you want  to run and save  the
file with the .bat extension.

You can then run the .bat file directly,  or  trough  an  external  program  such  as  the  Windows  Task
Scheduler.



Appendix C -
Encoding
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Appendix C - Encoding

 The multiple types of encoding available in cardPresso provides the best  flexibility  when working
with multiple card types.

To  ensure  a  good  knowledge  base,  in  this  chapter  we  will  further  develop  the  topic  of  encoding,
addressing each type of encoding and how to perform it within cardPresso.

  For testing purposes, we recommend disabling Front and Back  printing on the  print  w indow  (menu

File>Print) before printing.

Appendix C.1 - Magnetic Stripe

 Magnetic  encoding  is  a  contactless  type  of  encoding  performed  on  the  magnetic  stripe
(Magstripe) of a magnetic card. cardPresso supports both High Coercivity (HiCo) and Low Coercivity
(LoCo) magnetic cards.

There are up to 3 tracks on magnetic cards: Track 1, Track 2 and Track 3

Each Track supports a specific data type and size.

Track 1 - 80 Alphanumeric Characters
Track 2 - 40 Numeric Characters
Track 3 - 110 Numeric Characters

When a magnetic card type is created, cardPresso displays a visual representation of the Magstripe
on the Card Back view. This allows you to individually select each Track and edit the data to be
encoded directly trough the card design view.

You can access it by clicking the View Card Back button, or trough the menu View > Card Back.
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Appendix C.1.1 - Macros / Sentinels

 When encoding data into a Track the data must  follow a specific  set  of formatting rules.  These
are what determine which Track is being written and what data is to be written.  

To do this, encoders use a set of characters named Sentinels which determine where the data to be
encoded starts, where it's separated and where it ends.

Start Sentinel (generally '%') marks where the data to be encoded is going to begin.

End Sentinel (generally '?') marks where the data to be encoded ends.

Field Separator (generally '̂ ') separates different fields within a track.

ex: %Example^Text?

Where:

 '%' is the Start Sentinel.

 'Example ' is the first field of data to be encoded on the current track.

'̂ ' is the Field Separator.

'Text' is the second field of data to be encoded on the current track.

'?' is the End Sentinel.

 cardPresso  simplifies  the  process  by  using  Macros:  an  array  of  Sentinel  presets  for  several
manufacturers,  making changing Sentinels as  simple and easy as  a click  (see more on  Appendix
C.1.5).

Appendix C.1.2 - Adding Data to a Track

 Tracks in magnetic cards can work as easily as any other item in cardPresso when it  comes to
adding  data.  Simply  double  click  the  data  you  wish  to  add  data  to  encode,  input  the  data  to  be
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encoded on the input textbox and click the Close button. The change will be immediate:

This allows you to quickly add information into a magnetic card without any previous knowledge on
magnetic encoding.

Appendix C.1.3 - Adding a Database Source to a Track

 When  working  with  databases,  having  the  versatility  to  add  a  database  item  to  a  Track  is
fundamental. 

As with any item in cardPresso,  each Track contains  it's  own set  of properties  which can be used
for advanced encoding operations.

To add a database source to a Track:

1 - Select the Track in the Card Back view.

2 - On the Source tab, to the right, change the Source type to Database

3 - Select the Table where the database data is stored.

4 - Select the Column which contains the data to be encoded.
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All changes are immediately visible in the Design View: 

Appendix C.1.4 - Concatenation With Databases

 Concatenation allows you to stack  up to three database fields  within the same Track.  This  is
allows for a much more dynamic  and  space  efficient  data  generation  when  working  with  magnetic
tracks.

To use Concatenation on a Track select the Track, on the Track Properties select the Source
tab and click the Concatenation button.

The Concatenation pop-up provides the following options:

Data Prefix allows you to customize the text prefix that appears on the currently selected track.
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Ignore on print disables or enables encoding the Data Prefix.

Data Suffix allows you to customize a text suffix that appears on the currently selected track.

Ignore on print disables or enables encoding the Data Suffix.

Concatenate database columns enables or disables Concatenation

Column Prefix adds a text prefix to the data obtained from the selected data column.

Usually used for the Field Separator Sentinel

Column selects the database column from which to obtain the data.
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Appendix C.1.5 - Editing Magnetic Macros / Sentinels

 Different  encoder  manufacturers  use  different  Sentinels.  To  simplify  managing  sentinels
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cardPresso provides several Macros with preset Sentinels from several manufacturers.

You can change Macros trough the cardPresso menu File > Print Settings > Print Options >
Magnetic Encode > Macros and select your encoder/printer manufacturer.

To manually configure Macros open the cardPresso menu File > Print Settings > Print Options >
Magnetic Encode > Macros and select User Defined.

This will allow you to manually type the Start Sentinel and End Sentinel as shown bellow. All 3
Tracks must be manually set.

Appendix C.1.6 - Script Encoding

 cardPresso  also  allows  you  to  manipulate  Track  data  trough  Scripts.  This  powerful  feature
allows for even more advanced operations to customize your encoded data to it's full potential.
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In cardPresso each Tracks has a unique ID. Namely ISOTRACK1, ISOTRACK2, and ISOTRACK3
for Track 1, Track 2, and Track 3 respectively.
The data on this item can be manipulated trough scripting as with any other item.

 The encoded data must still follow each Track's data type (see more on Appendix C.1 - Magnetic

Stripe).

To create a Script click an empty area of the card design and select the Script tab in the
Properties Dock.. 

Scripts can also be added to an item by selecting it and clicking the Script tab in the properties Dock.

On the Script tab you can select when the script should executed and on the text box, write the
script.

Ex: item.ISOTRACK1="Example Text"
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Appendix C.2 - Contact Encoding

 Contact  encoding  in  cardPresso  is  done  in  the  Encode  Operations window in  the  Encode
View. Here you can develop your customized encoding operations for all the supported contact  Card
Types.

This allows you to manipulate the data stored in your Card, the data in the Card Design Items and
the data stored in your database, if connected to one.

The code varies with each Card Type. cardPresso comes with sample code for the supported Card
Types designed to get you familiar with the basic operations of each Card Type.

Below is the sample code of an I2C script.
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Appendix C.3 - Contactless Encoding

 Contactless encoding in cardPresso is done in the Encode  Operations window in the Encode
View.  Here  you  can  develop  your  customized  encoding  operations  for  all  the  supported  contact
Contactless Types.

This allows you to manipulate the data stored in your Card, the data in the Card Design Items and
the data stored in your database, if connected to one.

The code varies with each Card Type. cardPresso comes with sample code for the supported Card
Types designed to get you familiar with the basic operations of each Card Type.

Below is the sample code of a Mifare script.
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Appendix D - Barcodes

 Barcodes are a staple of today's industry and cardPresso follows trough in this feature as well.

Supporting 1D and 2D barcodes libraries  with  various  customizations  allows  for  a  wide  application
area.

To create a barcode simply  click  on the New  Barcode  or New  2D Barcode  button on the Design
Toolbar and then click-drag the new barcode to the size you want.

  

Appendix D.1 - 1D Barcode

 A 1D Barcode is the most common barcode type also known as a Linear Barcode.

 To create a 1D Barcode  click  the New  Barcode  button in the Design  Toolbar  or  trough  the
cardPresso menu Tool>Barcode.
You can then click-drag to place the new barcode with the desired size.

To customize the barcode, select it and click the Barcode separator in the Properties Dock.

The following options are availlable:

Symbology lets you select the symbology the barcode should use.

Barcode color lets you change the color of the barcode.

Module width lets you customize the width of the module.

Bearer bar customizes the positioning and shape of the barcode bearer bar.

Bearer width customizes the width of the Bearer Bar.

Quiet zone customizes the size of the quiet zone.

Human readable customizes or disables the barcode caption text.

Font customizes the size of the caption text.

CheckDigit enables or disables the Check Digit.
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Appendix D.2 - 2D Barcode

 A 2D Barcode also know as a matrix  code,  is  an advanced barcode type which can hold more
data per area. 

 To create a 2D Barcode  click  the New  2D Barcode  button  in  the  Design  Toolbar  or  trough
the cardPresso menu Tool>2D Barcode.

You can then click-drag to place the new barcode with the desired size.

To customize the barcode, select it and click the Barcode separator in the Properties Dock.

The following options are availlable:

Symbol format  changes the symbol format of the barcode.

Barcode color changes the color of the barcode.

QRCode Format changes the barcode encode system.

Module Width changes the width of the barcode.
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Mask changes the barcode mask.

EC Level changes the error correction level.

Size/Version changes the barcode size/version.

Appendix D.3 - Database Generated Barcodes

 cardPresso's barcodes also supports  having database  items  as  the  data  source.  This  means
cardPresso can dynamically generate barcodes using the data from an existing database.

As with any item in cardPresso,  each  Barcode  contains  it's  own  set  of  properties  which  can  be
used for advanced barcode generation.

To add a database source to a Barcode:

1 - Select the Barcode in the Card Design view.

2 - On the Source tab, to the right, change the Source type to Database

3 - Select the Table where the database data is stored.
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4 - Select the Column which contains the data to be written on the Barcode.

Concatenation allows you to stack  up to three database fields  within the same  Barcode.  This  is
allows for a much more dynamic and space efficient data generation when working with barcodes.

To use Concatenation on a Barcode click the Concatenation button on the Source tab.

The Concatenation pop-up provides the following options:

Data Prefix allows you to customize the text prefix that appears on the currently selected track.

Ignore on print disables or enables encoding the Data Prefix.

Data Suffix allows you to customize a text suffix that appears on the currently selected track.
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Ignore on print disables or enables encoding the Data Suffix.

Concatenate database columns enables or disables Concatenation

Column Prefix adds a text prefix to the data obtained from the selected data column.

Column selects the database column from which to obtain the data.

Appendix D.4 - Script Generated Barcodes

 cardPresso also allows you to manipulate Barcode  data trough Scripts.  This  powerful  feature
allows for even more advanced operations to use your barcodes to their full potential.

In cardPresso the data on this item can be manipulated trough scripting as with any other item.

The encoded data must still follow each Barcode's format rules.

To create a Script click an empty area of the card design and select the Script tab in the
Properties Dock.. 

Scripts can also be added to an item by selecting it and clicking the Script tab in the properties Dock.

On the Script tab you can select when the script should executed and on the text box, write the
script.

 Ex: in the example below the QR code being used was given the ID QR. 

Result:
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Appendix E - Link Image to DB Field

 Pictures  and  images  are  a  recurring  element  of  ID  cards.  When  connected  to  a  database
cardPresso allows you to quickly set up a database field as a source for images on your computer.

To set a database field as a link to an image file follow these steps:

1 - Locate the database field that contains the name of the picture files. In the example image below,
the field name is Image File Path:

2 - Right click the database field to open it's  Properties menu and change change the Data  Type
to Indexed Image. 

3 - Before closing the Properties menu,  click  the  "..."  button  to  the  right  of  the  Data  Type  drop
down list.

4  -  On  the  Indexed  Image  Properties menu  in  the  Images Folder  type  the  path  to  the  folder
which contains your images.
Alternatively, click the "..." button to the right of the Images Folder path and browse to your images
folder.
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When you're done. Click the OK button on the Indexed Image  menu.  Then click  the OK button on
the Properties menu and finally click the Database refresh button as prompted.

When  refreshed,  if  correctly  configured  and  the  database  field  contains  valid  image  paths,  the
database field will now show the images from the folder.
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